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การใช้ Joomla 3.9x เบือ้งต้น 
 

 

Joomlaคืออะไร 

 Joomla (จมูล่า) คอื CMS (ซเีอม็เอส) ตวัหน่ึงจากหลายๆ ตวัทีไ่ดร้บัความนิยมในปจัจบุนั ส าหรบั 
CMS มาจาก ค าว่า "Content Management System ซึง่หมายถงึ ระบบบรหิารจดัการเน้ือหาของ
เวบ็ไซต ์  นัน่หมายความว่า สิง่ทีเ่ราจะตอ้งดแูลกค็อืเนื้อหาของเวบ็ไซต ์ เช่น การเพิม่บทความ การเพิม่
รปูภาพ หรอืการปรบัแต่งโยกยา้ยโมดลูต่างๆ โดยไมจ่ าเป็นตอ้งมานัง่เขยีน Code ดว้ยภาษา HTML, PHP , 
SQL เพยีงแต่เรยีนรูว้ธิกีารตดิตัง้ การปรบัแต่ง การใชง้าน CMS เท่านัน้  ส าหรบั Code ต่าง ๆ ทีน่ ามาสรา้ง 
และออกแบบเวบ็ไซต ์ จะท าโดยทมีงานของผูพ้ฒันา CMS ของแต่ละทมี ซึง่ท าใหป้ระหยดัเวลาในการสรา้ง 
และออกแบบเวบ็ไซต ์ไดอ้ยา่งมาก 

       Joomla เป็น CMS ทีไ่ดร้บัความนิยมเป็นอนัดบัตน้ ๆ  เพราะมรีะบบการจดัการเน้ือหาทีม่รีปูแบบสากล 
การปรบัแต่งหน้าตาของเวบ็ไซตท์ าไดง้่าย เพราะถูกออกแบบมาใหร้องรบักบัเทคโนโลยกีาร ออกแบบ
เวบ็ไซต ์ สมยัใหม ่ นอกจากนี้คุณยงัสามารถ Download Template ไดอ้ยา่งมากมายมทีัง้แบบทีส่ามารถ
น ามาใชง้านไดฟ้ร ีหรอืหากตอ้งการ Template (เทมเพลต) ทีม่ปีระสทิธภิาพ และมคีวามสวยงาม กส็ามารถ
หาซือ้มาใชไ้ด ้ เพราะมเีวบ็ไซตท์ีใ่หบ้รกิารจดัท า Template ของอยูม่ากมาย จดุเด่นอกีจดุหนึ่งกค็อื
ม ีExtension (ส่วนเสรมิ) จ านวนมากใหเ้ราสามารถน ามาประยกุตใ์ชง้าน เช่น Component (คอมโพเน้น) , 
Module (โมดลู), Plugin (ปลัก๊อนิ) มทีัง้แบบฟร ีและแบบตอ้งช าระเงนิ ส าหรบัเวบ็ไซตอ์ยา่งเป็นทางการคอื 
www.joomla.org   เป็นศูนยร์วมข่าวสารการ Update Joomla และคุณสามารถ Download extension ต่างๆ  

      Joomla มกีาร Update (อพัเดท) อยา่งสม ่าเสมอ ท าใหเ้รามัน่ใจไดว้่าการ ออกแบบเวบ็ไซต ์ดว้ย CMS 
Joomla จะมคีวามปลอดภยั ซึง่ปจัจบุนั เป็นรุน่ 3.9.10 และทีส่ าคญัทีสุ่ดคอื รองรบัภาษาไทย 100% เพราะ
มทีมีงานทีค่อยดแูลเรือ่งภาษา  

ข้อดีของ Joomla 

1. ตดิตัง้งา่ยไดเ้วบ็ไซตอ์ย่างมอือาชพี 

2. ควบคุมหน้าตาเวบ็ไซตด์ว้ยเทม็เพลต 

3. สรา้งและจดัการเน้ือหาไดง้า่ย 

4. รอบรบัการท างานหลายๆ คนพรอ้มกนั 

5. เสถยีร ปลอดภยั อปัเดตสม ่าเสมอ 

6. ไมต่อ้งยดึตดิกบัคอมพวิเตอรห์รอืซอฟตแ์วรใ์ดๆ สามารถท างานไดทุ้กๆ เบราเซอร ์
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https://www.mindphp.com/%E0%B8%84%E0%B8%B9%E0%B9%88%E0%B8%A1%E0%B8%B7%E0%B8%AD/73-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3/2073-cms-%E0%B8%84%E0%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A324.html
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7. มสีงัคมออนไลน์ทีม่ขีอ้มลูช่วยเหลอืจ านวนมาก 

8. มกีารพฒันาภาษาไทยอยา่งเป็นทางการ 

9. สมบรูณ์ดว้ยโปรแกรมเสรมิทีห่ลากหลาย 

10. มกีารอพัเดทตวัโปรแกรมอยูเ่สมอเพื่อความปลอดภยั 

ลกัษณะของเวบ็ไซต ์Joomla 

    Front End ส่วนหน้าตาแสดงผลของเวบ็ไซต์ทีผู่เ้ยีย่มชมเวบ็ไซต ์สามารถเขา้มาดเูวบ็ไซตข์องเราได้ 

 

 
 

 

เมนูการใช้งาน 

Content Module 

Module 

Main Menu 
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หน้าจอเวบ็ไซตผ์ูด้แูลระบบ Administrator 

 
การเข้าสู่ระบบเทมเพลต็เวบ็ไซต ์Joomla กรมส่งเสริมสหกรณ์ 

1.เปิดเบราเซอร ์(โปรแกรมท่องอนิเตอรเ์น็ต) ขึน้มา พมิพ ์URL ในช่อง URL ดงันี้ 

                            __________________________________________ 

** เบราเซอร ์ท่ีสามารถใช้งานได้กบัเวบ็ไซต์ Joomla ได้ทุกเบราเซอร ์ดงัน้ี 

 

                                Chome          Firefox              IE             Opera           Safari 

2. ท าการลอ็กอนิดว้ย Username Password ของท่าน 

 

 

ใส่ช่ือผูใ้ช้ และรหสัผา่น 
จากนัน้คลิกปุ่ มเข้าสู่ระบบ 

หากเข้าสู่ระบบไม่ได้ ให้ตรวจสอบการพิมพต์วัสะกดให้ถกูต้อง  
ตวัอกัษรเลก็และใหญ่ มีผลต่อการลอ็กอินเขา้สู่ระบบ  
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เมือ่เขา้สู่ระบบเรยีบรอ้ยแลว้จะเขา้สู่หน้าจอผูด้แูลระบบ หรอื Administrator 

  

 

 

การเปล่ียนรหสัผา่นเพ่ือความปลอดภยั 

    

 
 

เมนูการใช้งาน 

คลิกเพื่อดหูน้าเวบ็ไซต ์

เมนูลดั 

ส่วนแสดงวา่ท่านท างานอยูท่ี่ส่วนใด 

เวอรช์ัน่ ออกจากระบบ 

1.คลิกสญัลกัษณ์ 

2.คลิก Edit Account 

3.ใส่รหสัผ่านใหม่ และ
ยืนยนัรหสัผ่าน 

เม่ือเปล่ียนรหสัเรียบร้อยแล้ว ให้ท า

การออกจากระบบ และเข้าสู่ระบบใหม่ 

4.คลิกปุ่ ม บนัทึก&ปิด 

จ านวนผูเ้ข้าระบบ 

Part 2 : การเซทค่าระบบต่างๆ บนเวบ็ไซต์ 
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การตัง้ค่าระบบหลกั 

เพื่อเป็นการ Setup ค่าต่างๆ ใหก้บัเวบ็ไซตเ์พื่อทีจ่ะท างานไดร้วดเรว็ขึน้ และเพื่อใหเ้วบ็ไซตข์องเรา
รองรบักบัเทคโนโลยกีารคน้หาเวบ็ไซต ์Search Engine Optimization (SEO) โดยไปที ่ 
ระบบ -> ตัง้ค่าระบบหลกั 
 

 

 

 

 

 

** ตวัช่วยเขยีนเนื้อหา JCE จะมเีครือ่งมอืช่วยเขยีนเนื้อหาทีห่ลายหลาย 

1 

2 

3. ตัง้ค่าต่างๆ ตามต้องการ 

ตัง้ค่าตวัช่วยเขียนเน้ือหา เป็น 

Editor - JCE 
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4.ใส่ค าอธิบายเวบ็ไซต์ 

5.ใส่ค าค้นหา 

คลิกท่ีมุม เพ่ือยืดขยายช่อง 
การพิมพข้์อมลู 

คลิกปุ่ มบนัทึก & ปิด 

ในการท าใหเ้วบ็ไซตข์องท่านสามารถคน้หาใน Google ไดง้า่ย นัน้ ระบบ Search Engine ให้
ความส าคญักบัโครงสรา้งเนื้อหามากกว่า หวัขอ้เนื้อหา โดยหลกัในการสรา้งหวัขอ้หลกัและหวัขอ้ยอ่ย ที่

ถูกตอ้งคอื <h1>,<h2>,<h3>,….. เป็นล าดบัต่อเนื่องไปจนถงึ <h6>โดย Search Engine จะคน้หาขอ้มลูทีม่ ี
น ้าหนกัความส าคญัตามล าดบัจากหวัขอ้แทก็ทีก่ าหนด โดยมคีวามส าคญัมากกว่าขอ้ความธรรมดา 

 

ตวัอย่างการพิมพ ์ค าคน้หา ค าคน้หาที1่,ค าคน้หาที2่,ค าคน้หาที3่,.............ค าคน้หาที ่1000 
เช่น ศูนยเ์ทคโนโลยสีารสนเทศและการสื่อกสาร กรมส่งเสรมิสหกรณ์,ศูนยส์ารสนเทศ กรมส่งเสรมิสหกรณ์

,ITC CPD,ไอทกีรมส่งเสรมิสหกรณ์ 
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ความเข้าใจในการจดัการ Content บนเวบ็ไซต ์

 ในการจดัท าเวบ็ไซตจ์ะตอ้งมกีารออกแบบโครงการขอ้มลูในเวบ็ไซตก์่อน โดย
ก าหนดการแบง่กลุม่ขอ้มลูเป็นกีก่ลุม่ แต่ละกลุม่มกีลุม่ยอ่ยอกีหรอืไม ่เพือ่น าไปเป็นโครงสรา้ง
เวบ็ไซตใ์หเ้หมาะสม 

 ประเภทและโครงสร้างของ content ใน Joomla 

1. เน้ือหา (Article) คอืขอ้มลูหรอืเน้ือหาในแต่ละหน้าของเวบ็ไซต์ 
2. หมวดหมู ่(Category) คอืหมวดหมูข่อง เน้ือหา เราสามารถสรา้งหมวดหมู่
หลกัและหมวดหมูย่อ่ยไดไ้มจ่ ากดั 

 ความสมัพนัธข์องเน้ือหา (Article) และหมวดหมู่ (Category) 

 

 

 

 

 

 

 

 

 

จากภาพ Category หรอื หมวดหมู่ เปรยีบเสมอืน โฟลเดอรท์ีไ่วเ้กบ็ขอ้มลูต่างๆ ในระบบ 
จากภาพ Article หรอื เนื้อหา เปรยีบเสมอืนไฟลต่์างๆ ทีถู่กเกบ็อยูใ่นโฟลเดอรน์ัน่เอง  

** ในการสรา้ง Content ต่างๆ ในระบบเวบ็ไซต ์Joomla นัน้ ท่านควรจะสรา้งๆ หมวดหมูห่รอื Category 
ก่อนทีจ่ะสรา้งเนื้อหา Article เพื่อสะดวกในการจดัการการนัน่เอง 

 

 

 

หมวดหมู่ย่อย 1 
Sub Category 1 

หมวดหมู่ย่อย 2 
Sub Category 2 

 

หมวดหมู่ 1 
Category 1 

 

 

 

เน้ือหา 1 
Article 1 

เน้ือหา 2 

Article 2 

เน้ือหา 3 
Article 3 

Part 3 :การสร้าง บทความ เน้ือหาเวบ็ (content) 
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ตวัอย่างการท าโครงสร้างข้อมลูเพ่ือจ าแนกเน้ือหาต่างๆ บนเวบ็ไซต์ 

 

 

 

1. การสร้างหมวดหมู่ (Category) 

   1.1 ไปทีเ่มนู เนื้อหา > หมวดหมู ่> เพิม่หมวดหมูใ่หม่ 

 
1.2 ตัง้ชื่อหมวดหมูต่ามตอ้งการ 

 

เก่ียวกบัสหกรณ์

วิสยัทศัน์ พนัธกิจ

ประวติัสหกรณ์

บุคลากร

สินค้าและบริการ
สินค้าของเรา

บริการของเรา

ตัง้ช่ือหมวดหมู่ตามต้องการ ใส่ช่ือ เอเลียสต์ามต้องการ 

หมวดหมู ่ เน้ือหา 
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** เอเลียส ์คือ ช่ือท่ีจะแสดงแทนช่ือหน้าข้อมูลเวบ็เพจท่ีเราสร้างขึ้น หากเราตัง้ช่ือ เอเลียส์เป็นอะไร 

กจ็ะไปปรากฏท่ีแถบแสดง URL บนเบราเซอร ์เราควรตัง้เอเลียส ์เป็นภาษาองักฤษ ไว้ใช้ในการ
อ้างอิงการเรียกเวบ็เพจขึ้นมาแสดง 

1.3 จากนัน้กดปุ่ม บนัทกึ 

การลบหมวดหมู ่

1. ไปเมนู เนื้อหา เลอืก หมวดหมู ่(คลกิค าว่าหมวดหมู)่ 

 

2. ท าการเลอืกหมวดหมูท่ีไ่มต่อ้งการ โดยท าเครือ่งหมาย  หน้าหมวดหมู่ทีไ่มต่้องการ 
3. คลกิทีปุ่ม่ถงัขยะ เพื่อลบ 

 

** ในการลบหมวดหมูห่รอืเนื้อหานัน้ในความเป็นจรงิแลว้ หมวดหมูห่รอืเนื้อหานัน้ ยงัไมไ่ดถู้กลบออกไป
จากระบบจรงิ เพยีงแต่ท าการยา้ยหมวดหมูห่รอืเนื้อหานัน้ ยา้ยไปไวใ้นถงัขยะ และเราสามารถกูค้นื
หมวดหมูห่รอืเนื้อหาทีเ่ราลบไปได้ 

 

 

 

 

2 3 
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การกู้คืนหมวดหมู่หรือเน้ือหาท่ีลบลงถงัขยะกลบัมาใช้งานใหม่ 

1. ไปทีเ่มนู เนื้อหา เลอืกหมวดหมู ่(คลกิทีค่ าว่าหมวดหมู)่  // ถา้ตอ้งการกูค้นืเน้ือหา ไปทีเ่มนู เนื้อหา เลอืก 
เนื้อหา (คลกิทีค่ าว่าเนื้อหา) 

 

2. คลกิทีปุ่ม่ เครือ่งมอืคน้หา 
3. เลอืกสถานะ อยูใ่นถงัขยะ 

 

4. เราจะเจอหมวดหมู่หรอืเนื้อหาทีล่บไป 
5. เลอืกหมวดหมูห่รอืเน้ือหาทีต่อ้งการกูค้นื โดยการคลกิ หมวดหมูห่รอืเน้ือหาทีต่อ้งการ จากนัน้คลกิปุ่ม 
เผยแพร่ 

 

2 

3 

 5 
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2. การสร้างเน้ือหา Article 

    2.1 ไปทีเ่มนู เนื้อหา > เนื้อหา > เพิม่เนื้อหาใหม่ 

 
  2.2 พมิพเ์นื้อหาทีต่อ้งการ 

 

เมือ่พมิพข์อ้มลูทีต่อ้งการเสรจ็เรยีบรอ้ยแลว้ เซทค่าทางดา้นขวามอื 

 

ตัง้ช่ือเน้ือหาตามต้องการ 

พิมพข้์อมลูตามต้องการ 

เลือกสถานะ  

เลือกหมวดหมู่ คือ ให้เน้ือหาน้ีอยู่ในหมวดหมู่ใด 

เลือกเด่น ให้เน้ือหาน้ีแสดงอยู่ในหน้าแรกของ

เวบ็ไซตห์รือไม่ 

ใส่เอเลียสภ์าษาองักฤษ 
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ค าอธิบาย 

 

ลกัษณะการบนัทึกข้อมลู 

 

 

 

------------------------------------------------------------------------------------------------------------------------------------- 

เคร่ืองมือต่างๆ ในการพิมพข้์อมลู  

 

1. Font Family คอืแบบอกัษร // Font Size คอืขนาดตวัอกัษร 

2. เครือ่งการสรา้งตาราง ลบตาราง ลบแถว เพิม่แถว และผสานเซลล์ 

3. เคร่ืองมือ การล้างรปูแบบต่างๆ ท่ีติดมากบัโปรแรมอ่ืนเช่น Word , Excel ,Powerpoint เพ่ือให้

สามารถจดัรปูแบบข้อมลูได้ 

4. การท าลงิคเ์ชื่อมโยงขอ้มลู 

5. การแทรก Read more หรอื อ่านเพิม่เตมิ 
 

- เผยแพร ่คือ ให้แสดงผลบนเวบ็ไซตไ์ด้  
- ไม่เผยแพร ่คือ ซ่อนการแสดงผลบนเวบ็ไซต ์
- คลงัเน้ือหา คือ ให้เน้ือหาน้ี ไปเกบ็อยู่ในคลงัเน้ือหา 
- อยู่ในถงัขยะ คือ ให้เน้ือหาน้ีอยู่ในถงัขยะ(ลบ) 

บนัทึกเน้ือหาน้ี กจ็ะค้างอยูใ่นหน้าเน้ือหานัน้
ไม่เปล่ียนหน้าไปไหน 

บนัทึกเน้ือหาน้ี แล้วปิดหน้าเน้ือหาน้ี 

บนัทึกเน้ือหาน้ี และปิดหน้าเน้ือหาน้ี แล้วท าการสรา้ง
หน้าการสรา้งเน้ือหาใหม่เปลา่ๆ ให้อตัโนมติั 

1 
2 

4 5 

3 
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การแทรกรปูภาพลงในเน้ือหา 

การใช้เคร่ืองมือการแทรกรปูภาพ แบบท่ี 1  

1. เอา cursor เมาสไ์วต้รงจุดทีต่อ้งการแทรกรปูภาพ 
2. คลกิปุม่ใส่รปูภาพ 

 

3. เลื่อน scrollbar ลงดา้นล่างคลกิปุม่ Choose File เพือ่ท าการเลอืกรปูส าหรบั Upload ขอ้มลู  
4. จากนัน้กดปุ่ม เริม่อพัโหลดไฟล ์

 

5. รอสกัครู ่รปูทีอ่พัโหลดจะปรากฏในช่องแสดงรปูตวัอยา่ง จากนัน้คลกิทีร่ปู 
6. สงัเกตุว่าเมือ่คลกิทีร่ปูแลว้ ช่องทีอ่ยูร่ปูม ีURL ชื่อรปูปรากฏหรอืไม ่หากไม่ม ีจะแทรกรปูทีต่อ้งการไมไ่ด้ 
7. คลกิปุม่ เพิม่ในเน้ือหา 

2 

3 4 
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ผลลพัธ ์

 

 

การใช้เคร่ืองมือการแทรกรปูภาพ แบบท่ี 2 
1. คลกิทีส่ญัลกัษณ์ insert/modify images 

 

5 
7 

6 

1 
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2. คลกิทีส่ญัลกัษณ์ Upload 

 

 

3. คลกิทีปุ่ม่ Browse แลว้เลอืกไฟลท์ีต่อ้งการสามารถเลอืกไดห้ลายๆ ไฟลพ์รอ้มๆ กนั ชื่อไฟลจ์ะปรากฎอยู่
ทีช่่อง Upload 
4. คลกิปุม่ Upload เพื่อ อพัโหลดไฟลท์ีเ่ลอืก 
5. รปูทีอ่พัโหลดเสรจ็แลว้จะปรากฎอยูใ่นชองแสดงรปู  
6. คลกิทีช่ื่อรปู แลว้กดปุม่ Insert 

2 

3 4 
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การแทรกตารางในเน้ือหา 

1. คลกิทีส่ญัลกัษณ์ตาราง แลว้วาดช่องตารางตามตอ้งการ 

 

2. ตารางจะปรากฏในพืน้ทีก่ารพมิพ ์แต่ตารางจะยงัไม่มสีแีละเสน้ตาราง เราตอ้งเป็นคนก าหนดค่าต่างๆ 
เองตามตอ้งการ 

1 

5 

6 
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3. คลกิลากตารางใหม้คีวามกวา้งตามตอ้งการ 

 

4. เซทค่าตารางต่างๆ ใหท้ าการคลกิขวาในตารางทีต่อ้งการ  

 

  

 

2 

Table Properties เป็นการเซทค่าทัง้ตาราง 

Cell เป็นการเซทค่าแต่ละเซลล(์ช่อง) 
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4.1 เซทค่าทัง้ตาราง  

    

        4.2 เซทค่าต่างๆ แต่ละช่องเซลส ์สามารถลากแถบด าคลุมไดห้ลายๆ เซลส ์หรอื ทลีะเซลสก์ไ็ด ้
จากนัน้คลกิขวา เลอืก Cell > Table Cell properties 

 

4.3 เซทค่าต่างๆ แต่ละช่องเซลตามตอ้งการ 

  

เซทค่าความกว้าง, ความสูง 
ความหนาเส้นขอบ , ช่องว่าง
ระหว่างเซล 

เซทสีเส้นขอบและ สีทัง้ตาราง 

4.2 

ลากแถบด าคลุมช่องท่ีต้องการ ถ้า

ต้องการเปล่ียนแค่ 1 ช่องให้น า 
cursor เมาส ์วางในช่องนัน้ 

เซทค่าความกว้าง, ความสูง 

ความหนาเส้นขอบ , ช่องว่าง
ระหว่างเซล 

เซทสีเส้นขอบและ สีทัง้ตาราง 
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ผลลพัธ์ 

 

** ในการท าตารางแนะน าว่า ให้เซทค่าเพียงครัง้เดียว เช่น ท าสี ท าเส้นขอบ จดัข้อความ  
อย่าท าการเซทหลายๆ ครัง้  เพราะอาจจะต้องเซทใหม่ตัง้แต่แรกท่ีท าไว้ 

เคร่ืองมือตารางเพ่ิมเติม 

 

 

 

 

 

 

การท าลิงคก์ารเช่ือมโยง (Link) 

 การท าลงิคค์อืเชื่อมโยงขอ้มลูในเวบ็ไซต ์แบ่งออกเป็น 3 ประเภท 
1. เชื่อมโยงเนื้อหาภายในเวบ็ไซต์ 
2. เชื่อมโยงไฟลเ์อกสาร 
3. เชื่อมโยงภายนอกเวบ็ไซต ์

 

 

 

เก่ียวกบัการเพ่ิมแถว ลบแถว 

เก่ียวกบัการเพ่ิมคอลมัน์ ลบคอลมัน์ 

ผสานเซลส ์และยกเลิกผสานเซลส ์
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วิธีการท าลิงค ์
1. ท าการเลอืกขอ้ความหรอืรปูทีต่อ้งกาท าลงิค์ 
2. คลกิสญัลกัษณ์การท าการเชื่อมโยง (Insert/Edit Link) 

 

ใส่ลิงคต์ามต้องการ 

 

 

2 

1 

ใส่ URL เวบ็ไซตห์รอื URL จากGoogle 
Drive ท่ีต้องการ 

คลิกเพื่ออพัโหลดไฟลเ์อกสารต่างๆ เช่น 
PDF, Word, Excel , Powerpoint ,ฯลฯ 

ค้นหาช่ือเน้ือหาท่ีต้องการ 

หากต้องการเลือกเน้ือหาท่ีมีอยู่บนเวบ็คลิก 
ค าว่า Content 

คลิกเน้ือหาท่ีต้องการ 

ให้ท าการเปิดลิงคแ์บบใด 
Open in new window คือเปิดหน้าต่างใหม ่

เป็นส่วนเลือกท าลิงคเ์น้ือหาภายใน 
เวบ็ไซตเ์ดียวกนั 
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การใช้งานปุ่ ม Read More (อ่านเพ่ิมเติม) 

เนื้อหาทีแ่สดงทีห่น้าแรกของเวบ็ไซตจ์ะมคีวามยาวของขอ้มลูมาก หากน ามาแสดงทัง้หมด จะท าให้
รปูแบบหน้าเวบ็ไซต ์ไมส่มดุล และไมเ่ป็นระเบยีบ ดงันัน้ปุ่ม read more จงึเป็นฟงักช์ัน่ ตดัขอ้มลูทีจ่ะ
แสดงผลหน้าแรกใหแ้สดงแค่บางส่วน และมปีุม่อ่านเพิม่เตมิขึน้มา เพื่อใหผู้ใ้ชง้านตอ้งการอ่านขอ้มลูทัง้หมด
คลกิเพื่ออ่านขอ้มลูไดห้มด วธิกีารดงันี้ 
 
1. เอา cursor เมาสไ์วต้รงต าแหน่งทีต่อ้งการตดัค าเพื่อให ้แสดงผลบางส่วนบนหน้าเวบ็ 

 
2. คลกิทีปุ่ม่ Read More 

 
3. จะปรากฏเสน้ก าหนดขอบเขตของ Read more 

 

จดุท่ีต้องการตดัข้อมูลให้แสดงหน้าแรก 

2 

เส้นแบ่ง Readmore 
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        ผลลพัธท่ี์ได้ 

 

สถานะต่างๆ ของเน้ือหาในระบบ 

 

** วธิกีารเปลีย่นสถานะเนื้อหาต่างๆ ใหค้ลกิทีส่ญัลกัษณ์นัน้ไดเ้ลย 

** หากเนื้อหาใดมสีถานะ รปู เครือ่งหมายตกใจ สเีหลอืง  หมายความว่าเนื้อหานัน้มกีารตัง้เวลาการ
แสดงผล 

** หากเนื้อหาใดมสีถานะ รปู แมกุ่ญแจเกดิขึน้  หมายความว่า เนื้อหานัน้ มกีารบนัทกึไมค่รบถว้น 
อาจจะท าใหเ้นื้อหานัน้แสดงผลบนหน้าเวบ็ไมส่มบรูณ์ ใหท้ าการเขา้ไปในเนื้อหานัน้แลว้ท าการบนัทกึซ ้าอกี
ครัง้หนึ่ง 

กากบาทสีแดงคือไม่เผยแพรเ่น้ือหานัน้ขึน้เวบ็ไซต ์

เครือ่งหมายถกูสีเขียวคือ เผยแพรเ่น้ือหานัน้ขึน้เวบ็ไซต ์

เครือ่งหมายดาวสีเหลือง คือ เน้ือหาน้ีเป็นเน้ือหาเด่นแสดงอยู่หน้าแรก
ของเวบ็ไซต ์

เครือ่งหมายดาวสีขาว คือ เน้ือหาน้ีไม่ได้เป็นเน้ือหาเด่น 

ปุ่ มอ่านเพ่ิมเติมจะปรากฏขึน้มา 
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การท าข่าวกิจกรรม 
ส่ิงท่ีจะต้องเตรียมเพ่ือท าข่าวกิจกรรมมีดงัน้ี 
1. เนื้อหาข่าว 
2. ภาพขา่วทีจ่ะท าเป็น Gallery ภาพขา่ว 
3. ภาพขา่วตวัอยา่ง (อาจจะท าเป็นรปูภาพตวัอยา่งขนาดเลก็ เพื่อให ้Browser IE แสดงผลตวัอยา่งขา่วไม่
ผดิเพีย้น) 

เร่ิมท าข่าวกิจกรรม 
ค าแนะน า : ในการท าข่าวกิจกรรม แนะน าว่า ควรท าข่าวเก่าท่ีสดุก่อน จึงถึงข่าวใหม่ท่ีสดุ เพ่ือจะได้
ไม่ต้องเซทค่าการเรียงล าดบัข่าวให้ยุ่งยาก 

1. ท าการอพัโหลดรปู Gallery ทีม่เีดยี  

 

2. สรา้งโฟลเดอรใ์หม ่เพื่อเกบ็รปูใน Gallery ท าการตัง้ชื่อโฟลเดอร ์โดยชื่อโฟลเดอรเ์ป็นภาษาองักฤษ เช่น 
ขา่ววนัที ่20 มถุินายน 2560 กต็ัง้ชื่อเป็น 20june2560  ถา้มหีลายๆขา่วในวนัเดยีว อาจจะตัง้เป็น 
20june2560_2 

 

 

2.1 
2.2 ตัง้ช่ือโฟลเดอร์ 

2.3 กดปุ่มสร้างโฟลเดอร์ 
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3. คลกิทีช่ื่อโฟลเดอรท์ีส่รา้งเพื่อเขา้ไปยงัโฟลเดอรน์ัน้ และท าการอพัโหลดไฟลล์งในโฟลเดอรท์ีส่รา้งไว ้ 

 
 
4. ท าการอพัโหลดไฟลร์ปูขึน้เวบ็ไซต ์โดยชื่อของรปูนัน้ ตอ้งเป็นภาษาองักฤษหรอืตวัเลขเท่านัน้ 

 

5. เมือ่เตรยีมรปูเรยีบรอ้ยแลว้ ท าการเริม่สรา้งเนื้อหา ไปทีเ่มนู เนื้อหา > เนื้อหา > เพิม่เนื้อหาใหม่ 

 

3 

4.1 คลกิปุ่ม อัพโหลด 

4.2 คลิกปุ่ม เลือกไฟล์ 

4.3 คลกิปุ่ม เร่ิมอัพโหลด 
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6. ตัง้ชื่อเนื้อหาตามขา่วทีต่้องการ

 

7. พมิพข์่าวทีต่อ้งการลงไป ตอ้งการตดัขา่วเพื่อใหแ้สดงทีห่น้าแรก ตรงไหนใหเ้อา cursor เมาสไ์ปวางตรง
นัน้ แลว้คลกิทีปุ่ม่ Readmore 

 

 

วาง cursor เพื่อจะท าการตัดข่าว 

คลิกปุ่ม Insert Readmore 

จะได้เส้น Readmore 
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ค าอธิบาย 

 

8. คลกิทีแ่ถบรปูและลงิค ์ เพื่อท าการใส่รปูตวัอยา่งทีจ่ะแสดงในหน้าแรก 

 

9. คลกิกลบัมาในแถบ เนื้อหา เพื่อพมิพค์ าสัง่ สรา้ง Gallery ภาพข่าว 
    พมิพ ์code ดงัต่อไปนี้ ในเนื้อหาข่าว {gallery}20june2560{/gallery}   ค าอธิบาย : 20june2560 คอืชื่อ
โฟลเดอรส์รา้งขึน้และอพัโหลดรปูข่าวเอาไว้ 

 

คือส่วนที่จะปรากฎในหน้าแรกของเว็บไซต์ 

คลิกปุ่มเลือก เพ่ือเลือกรูปส่วนต้น 

คลิกแถบรูปและลิงค์ 

พมิพ์โค๊ด เพื่อ สร้าง Gallery 
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10 เลอืกหมวดหมู ่ทีจ่ะเกบ็เนื้อหาไวใ้น หมวดหมู ่ขา่วกจิกรรม 
 และท าการบนัทกึและปิด 

 

11. เมือ่บนัทกึเรยีบรอ้ยแลว้ ท าการตดิดาวเหลอืง เพื่อท าเป็นเนื้อหาเด่น ใหป้รากฏทีห่น้าแรกของเวบ็ไซต์ 

 

 

 

 

เก็บไว้ในข่าวกิจกรรม 

คลิกดาวเหลืองท าเป็นเนือ้หาเด่น 

คือส่วนที่จะปรากฏในหน้าแรกของเว็บไซต์ 
ได้มาจากการแทรกปุ่ม insert readmore 

รูปตัวอย่าง เกิดจาก การใส่รูปและลิงค์ 
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การสร้างเมนูเช่ือมโยงเน้ือหา 

การท าเมนูเชื่อมโยงเนื้อหานัน้มกีารท าเมนูสองแบบ 

1. การท า Main Menu ทีอ่ยูด่า้นบน 

2. การท า Sub menu ยอ่ย 

 

วิธีการสร้าง Main Menu 

 1. ไปทีค่ าสัง่ เมนู > Main Menu > เพิม่เมนูใหม่ 

 

 2. ตัง้ชื่อเมนูทีต่อ้งการในช่องเมนู    3. ชนิดของเมนูนัน้คลกิปุม่เลอืกสนี ้าเงนิ 

 

Main Menu 

Sub Menu 

2 

3 

Part 4 :การสร้างเมนูเช่ือมโยงเน้ือหา 
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 4. เลอืกชนิดเมนูทีต่อ้งการ 

4.1 ใหเ้ลอืกเนื้อหา > เนื้อหาเดยีว 

 

 4.2 เลอืกเน้ือหา คลกิปุม่เลอืกสเีทา 

 

4.3 เลอืกเนื้อหาทีต่อ้งการ โดยคลกิไปทีช่ื่อเนื้อหาทีต่อ้งการไดเ้ลย หรอืคน้หาจากช่องคน้หา 

 

5. คลกิปุม่บนัทกึเพื่อท าการบนัทกึ Main Menu 

4.1 

4.1 

4.2 

4.3 

ค้นหาเน้ือหาท่ีต้องการ 
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ผลลพัธท่ี์ได้ เมนูท่ีสร้างใหม่จะปรากฎขึ้นด้านบน 

 

------------------------------------------------------------------------------------------------------------------------------------- 

** หมายเหต ุการสร้าง Main menu นัน้หากต้องการให้เมนูท่ีสร้างนัน้ คลิกแล้วเช่ือมโยงไปยงัเน้ือหา
ท่ีต้องการ , ลิงคไ์ฟล ์, ลิงค ์URL ท่ีต้องการ 

6. ท าเมนูเพื่อลงิคไ์ปหา URL ทีต่อ้งการ ใหค้ลกิที ่ลงิคร์ะบบ > URL 

        

7. ในช่องลงิคใ์ส่ URL ทีต่อ้งการ ช่องหน้าต่างเบราเซอรเ์ป้าหมายเลอืกตามตอ้งการ 

 

โดยวธิกีารใส่ URL นัน้พมิพไ์ดด้งันี้ 

http://www.cpd.go.th แบบน้ี ใส่ถกู               www.cpd.go.th แบบน้ีใส่ผิด 

8. คลกิปุม่บนัทกึเพื่อท าการบนัทกึ Main Menu 

6 

6 

7 

7 

เมนูท่ีเพ่ิมขึน้ใหม ่
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วิธีการสร้าง Sub Menu 

 ในการท า Sub Menu นัน้เราจะตอ้งสรา้ง Main Menu (เมนูแม)่ ทีอ่ยูด่า้นบนใหเ้รยีบรอ้ยเสยีก่อน 
จงึจะท า Sub Menu (เมนูลูก) ขึน้มาได ้

** การท า Main Menu ส าหรบั ท า Sub menu (เมนูแม่) 

1. ไปทีค่ าสัง่ เมนู > Main Menu > เพิม่เมนูใหม่ 

 

 2. ตัง้ชื่อเมนูทีต่อ้งการในช่องเมนู    3. ชนิดของเมนูนัน้คลกิปุม่เลอืกสนี ้าเงนิ 

 

 4. เลอืกชนิดเมนูทีต่อ้งการ เลอืกเป็น ลงิคร์ะบบ > URL ภายนอก 

 

2 

3 

4 

4 
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5. ช่องลงิก ์ใส่เครือ่งหมาย # เพื่อใหเ้มนูแม่นี้ ไมส่ามารถคลกิลงิคไ์ปได ้ใหเ้พยีงแคเ่อาเมาสว์างบน
เมนูแลว้จะมเีมนูลกู ปรากฏขึน้มา 

6. จากนัน้คลกิปุ่ม บนัทกึ 

 

** การท า Sub Menu (เมนูลกู) 

1. ไปทีค่ าสัง่ เมนู > Main Menu > เพิม่เมนูใหม่ 

 

 2. ตัง้ชื่อเมนูทีต่อ้งการในช่องเมนู    3. ชนิดของเมนูนัน้คลกิปุม่เลอืกสนี ้าเงนิ 
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4. เลอืกชนิดเมนูทีต่อ้งการ 

4.1 ใหเ้ลอืกเนื้อหา > เนื้อหาเดีย่ว 

 

 4.2 เลอืกเนื้อหา คลกิปุม่เลอืกสเีทา 

 

4.3 เลอืกเนื้อหาทีต่อ้งการ โดยคลกิไปทีช่ื่อเนื้อหาทีต่อ้งการไดเ้ลย หรอืคน้หาจากช่องคน้หา 

 

4.1 

4.1 

4.2 

4.3 

ค้นหาเน้ือหาท่ีต้องการ 
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 5.ท าการตัง้ค่าเมนูลกู ทางดา้นขวามอืดงันี้ 

 

อธิบายตวัอย่าง 

 

 

6. เมือ่เซทค่าเรยีบรอ้ยแลว้ กดปุม่ บนัทกึ 

------------------------------------------------------------------------------------------------------------------------------- 

 

 

 

 

เลอืกว่าเมนูลกูทีส่รา้งนี้จะใหอ้ยูภ่ายใต้ 
เมนูแม ่ตวัใด 

สญัลกัษณ์ – (หนึ่งขดี) หมายถงึเมนูทีอ่ยู ่
Level บนสุด 
สญัลกัษณ์ - - (สองขดี) หมายถงึ เมนูทีอ่ยู ่
Level รองลงมาจากบนสุด 

อยู่เลเวลบนสุด เปรียบเสมือน  
- (หน่ึงขีด) 

อยู่เลเวลรองจากบนสุด 

เปรียบเสมือน - - (สองขีด) 
- (หน่ึงขีด) 

อยู่เลเวลอนัดบัสาม 
เปรียบเสมือน - - -(สามขีด) 
- (หน่ึงขีด) 
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การท าเมนู ด้านข้างของเวบ็ไซต์ 

       การท าเมนูดา้นขา้ง จากเมนูของเวบ็ จะท าใหห้น้าขอ้มลูทีเ่ราเชื่อมโยงนัน้ จะไมม่โีมดลูอื่นตดิมาดว้ย 
ซึง่ต่างจากโมดลูทีเ่ราสรา้งเอง แบบก าหนด HTML เอง การสรา้งเมนูดา้นขา้งแบบก าหนด HTML เอง เมือ่
เชื่อมโยงไปยงัเนื้อหา จะมโีมดลูอื่นตดิมาด้วย 

ตวัอย่างเมนูด้านข้าง 

 
1. ท าการสรา้งหมวดหมู่ของเมนูขึน้มาใหม ่โดยไปที ่เมนู > การจดัการ > เพิม่กลุ่มเมนูใหม่ 

 

2. ท าการตัง้ชื่อ , ชื่อแบบยนูิค และท าการบนัทกึและปิด 
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3. เราจะไดก้ลุ่มเมนู Quick Links หรอืตามทีท่่านสรา้งขึน้มา 

 

4.ท าการสรา้งเมนูในกลุ่มของ Quick Linkโดยไปที ่เมนู >Quick Linkหรอืกลุ่มเมนูทีท่่านสรา้ง>เพิม่เมนูใหม่ 

 

5. ท าการสรา้งเมนูตามตอ้งการและบนัทกึและปิด 

 
6. จะไดเ้มนูทีท่่านสรา้งอยูใ่นกลุ่มเมนูทีส่รา้งขึน้มา 
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7. เมือ่ท าเมนูในกลุ่มเสรจ็แลว้ ท าการสรา้งโมดลู ชนิดเมนู เพื่อไวท้างขวาของเวบ็ไซต ์โดยไปที ่ 
ส่วนเสรมิ > โมดลู แลว้คลกิปุม่สรา้งใหม่ 

 

8. ท าการเลอืกชนิดโมดลู เป็น เมนู 

 

9. ตัง้ชื่อโมดลู เลอืกเมนู เป็น Quick Link หรอืกลุ่มเมนูทีส่รา้งไว้ 

 

7.1 
7.2 

8 

9.1 

9.2 
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10. คลกิแถบการก าหนดแสดงทีเ่มนู ก าหนดการแสดงผลว่าจะแสดงผลทีห่น้าใดบา้ง 

 

11. กลบัมาทีแ่ถบโมดลู ทางดา้นขวามอื เป็นส่วนการเลอืกว่า ใหโ้มดลูทีส่รา้งนัน้จะแสดงทีต่ าแหน่งใด 
ต าแหน่งดา้นขวามอืของเวบ็ในเทมเพลต Protostar คอืต าแหน่ง Right Position 7  

 

12 เมนูทีท่่านสรา้งกจ็ะปรากฏทางดา้นขวามอืของเวบ็ 

 

10.1 

10.2 

10.3 
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การลบกลุ่มของเมนูท่ีไม่ต้องการ 

1. ไปทีเ่มนู > การจดัการ 

 
2. คลกิเลอืกกลุ่มเมนูทีต่อ้งการลบ 
3. คลกิปุม่ลบ 

 
** การลบกลุ่มของเมนูนัน้ จะท าให้เมนูย่อยท่ีสร้างอยู่ภายใต้กลุ่มของเมนู ถกูลบออกไปด้วย โปรด

ระวงัการลบเมนู หาท าการลบไปแล้ว สามารถไปกู้คืนในถงัขยะ เหมือนกบั การลบเน้ือหาได้ 

 

 

 

 

 

2 

3 
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การเซทหน้าแรกของเวบ็ไซต์ 
 การเซทหน้าแรกของเวบ็ไซตนั์น้ เราจะต้องไปเซทท่ี เมนู หน้าหลกั หรือ Home ซ่ึงหากท า

การลบเมนูน้ีออกไป จะท าให้หน้าแรกเวบ็ไซตไ์ม่สามารถเข้าได้ 

 1. เมนู > Main Menu  

 ** หากกลุ่มของเมนูใด มีสญัลกัษณ์ รปูบ้าน หมายความว่า ก าหนดกลุ่มของเมนูนัน้ให้เป็น
หน้าแรกของเวบ็ไซต์ 

 
 2. คลกิทีห่น้าหลกั เพือ่ท าการเซทคา่ต่างๆ โดยสงัเกตุวา่ เมนูใดทีม่สีญัลกัษณ์ ดาว
เหลอืง จะเป็นเมนูทีเ่ป็นหน้าแรกของเวบ็ไซต์ 

 
  3. เลอืกชนิดของเมนู โดยคลกิปุม่เลอืกสนี ้าเงนิ 

 
 

 

จดุสงัเกตดุาวเหลืองว่าเป็นหน้าแรกของ
เวบ็ไซต ์

2 

3 
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 4. เลอืกชนิดของเมนู เป็น เนื้อหา > เนื้อหาเด่น 

 
5. คลกิทีแ่ถบตวัเลอืกเคา้โครง 
6. เลอืกหมวดหมูท่ีต่อ้งการ ในทีน่ี่คอืข่าวกจิกรรม 
7. ก าหนดจ านวนขา่วกจิกรรมทีจ่ะแสดงบนหน้าเวบ็ไซต์ 

 
** บทความน า คือ เน้ือหาท่ีจะแสดงผลในแนวนอน ว่าจะให้ก่ีเน้ือหาในแนวนอน 

** เน้ือหารอง คือ เน้ือหาท่ีจะให้ปรากฏบนหน้าแรกของเวบ็ว่าจะให้ปรากฏก่ีเน้ือหา 
** คอลมัน์ คือ จ านวนคอลมัน์ของข่าวท่ีจะแสดงบนหน้าเวบ็ 

4 

4 

5 

6 

7 
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ค าอธิบาย : บทความรอง ท าการเซทไว ้6 จะแสดงเนื้อหาเด่นบนหน้าเวบ็ไซต ์6 ขา่ว และท าการเซท
คอลมัน์ไว ้3 หากเนื้อหาเด่นทีเ่กนิ 6 ขา่วขึน้ไป จะถูกแสดงในหน้าถดัไป 

 

แสดงผงัโครงการสร้างการวางเน้ือหาบนเวบ็ไซต ์Joomla 

 

ตวัอยา่ง ท่ีท าการเซทค่าดงัต่อไปน้ี 
บทความน า 0 

เน้ือหารอง 6 
คอลมัน์ 3 
ลิงค ์0 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 43 
 

การเรียงล าดบัเน้ือหาในการแสดงผล 

1. คลกิทีส่ญัลกัษณ์ เพื่อปลดลอ็ก การสลบัล าดบัเนื้อหา 

 

2. จดุไข่ปลาสามจดุ หน้าบทความจะเปลีย่นสจีากสเีทา กลายเป็นสดี า หมายความว่า สามารถเลื่อนล าดบั
เนื้อหาไดแ้ลว้ 

 

 

 

 

 

1 

2 
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3. ท าการคลกิคา้งทีปุ่่มไขป่ลาสามจดุ แลว้คลกิเมาสเ์ลื่อนล าดบัเน้ือหาตามตอ้งการ 

 

 

การเซทการแสดงผลหน้าเน้ือหา 

             ในหน้าเนื้อหาทีเ่ราสรา้งขึน้ระบบจะมกีารแสดง รายละเอยีดต่างๆ เช่น หมวดหมู ่ชื่อผูเ้ขยีน วนัที ่
ปุม่ต่างๆ เราสามารถปิดส่วนต่างๆ ไดด้งัน้ี 

 

 

 

 

คลิกแล้วลากเมาสเ์ลื่อนตามต้องการ 
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1. ไปทีเ่มนู ระบบ > ตัง้ค่าระบบหลกั 

 

2. คลกิที ่เมนูดา้นซา้ยมอื คลกิเลอืกเนื้อหา 

 

ท าการเปิดปิดการแสดงตาม
ความต้องการ 
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ระบบเทม็เพลต็ Joomla สามารถจดัการระดบัการเขา้ถงึขอ้มลู ไมว่่าจะเป็น เนื้อหา , เมนู และโมดลู ได ้
โดยในระบบเทม็เพลต็ Joomla แบ่งประเภทของสมาชกิของเวบ็ไซตท์ีส่ามารถเขา้ไปยงัเวบ็ไซตไ์ดด้งันี้ 
ประเภทของสมาชิก 

 

ซ่ึงในส่วนของสมาชิกประเภท Special ยงัสามารถแบ่งออกได้เป็นสองส่วน  
กลุ่มท างานส่วนผูด้แูลระบบ  
Manager คอื สามารถเขา้ส่วนผูด้แูลระบบได ้แต่ไมส่ามารถใชง้าน Component ได ้ 
Administrator คอื สามารถเขา้ส่วนผูด้แูลระบบได ้ท างานไดทุ้กอยา่งแต่ไมส่ามารถ เซทค่า Global   
                   Configuration ได ้ 
 
กลุ่มท างานหน้าเวบ็  
Author คอื สามารถเขยีนบทความได ้แกไ้ขบทความของตวัเองไดแ้ต่ไมส่ามารถเผยแพรไ่ด้  
Editor คอื สามารถเขยีนบทความได ้แกไ้ขบทความของคนอื่นได ้แต่ไมส่ามารถเผยแพรไ่ด้  
Publisher คอื สามารถเขยีนบทความได ้แกไ้ขบทความของคนอื่นได ้สามารถเผยแพรบ่ทความได้ 

 

 

 

 

 

 

Part 5 : การจดัการสมาชิกและการก าหนดระดบัการเข้าถึงเน้ือหา 
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การเพ่ิมสมาชิกใหม่จากส่วนระบบผูด้แูลระบบ  

1.ไปทีค่ าสัง่ สมาชกิ > การจดัการ > เพิม่สมาชกิใหม ่

 

2. กรอกขอ้มลูสมาชกิใหค้รบ โดยช่องทีม่เีครือ่งหมาย * หา้มเวน้ว่าง 

 

 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 49 
 
3. จากนัน้คลกิทีแ่ถบ เขา้อยูใ่นกลุ่ม เลอืกประเภท เป็น Registered จากนัน้คลกิปุ่มบนัทกึและปิด 

 

เม่ือเราก าหนดสมาชิกเรียบร้อยแล้วเรากส็ามารถ ก าหนดได้ว่า เมนูใด เน้ือหาใด หรือโมดลูใด ให้

เหน็ หรือใช้งานได้เฉพาะสมาชิกเท่านัน้ ได้ดงัน้ี  

การเปิดโมดลู Login สมาชิก  

การท าหน้าขอ้มลูใหเ้ฉพาะสมาชกิเขา้ไปใชง้านไดน้ัน้ จะตอ้งม ีส่วนทีส่มาชกิใชใ้นการ Login เขา้สู่ระบบ ซึง่ 
ในระบบ Joomla ไดม้ ีโมดูล Login ใหเ้ราสามารถตัง้ค่าการใชง้านไดว้ธิกีารตัง้ค่าโมดลู ลอ็กอนิ ท าไดด้งันี้ 
1. ไปทีส่่วนเสรมิ > โมดลู 
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2. คน้หาค าว่า Login ในช่องคน้หา  
3. เมือ่เจอผลการคน้หา คลกิเขา้ไปทีโ่มดลูทีช่ื่อว่า Login 

 

4. คลกิทีแ่ถบการก าหนดการแสดงทีเ่มนู และก าหนดการแสดงผล เป็นทุกหน้า 

 

5. ก าหนดต าแหน่งทีจ่ะวางโมดลู Login บนหน้าเวบ็ไซต ์
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จะปรากฏ โมดลู Login ท่ีหน้าเวบ็ไซต์ 

 

การสร้างเน้ือหา เฉพาะสมาชิก 

1.ไปทีเ่มนู เนื้อหา > เนื้อหา > เพิม่เนื้อหาใหม่ 

 
2. พมิพเ์นื้อหาทีต่อ้งการ 
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3. เมือ่พมิพข์อ้มลูทีต่อ้งการเสรจ็เรยีบรอ้ยแลว้ เซทค่าทางดา้นขวามอื 

 

** การเซทเมนูและโมดลูให้เฉพาะเข้าได้ กมี็วิธีการเซทแบบเดียวกนักบัท าเน้ือหาเฉพาะสมาชิก คือ 
ตรงการเข้าถึง ให้เลือกเป็น Registered 

 

 

 
 Extension ในระบบเทม็เพลต็ Joomla คอื สว่นเสรมิต่างๆ ทีท่ าใหเ้วบ็ไซตม์ปีระสทิธภิาพในการ
ท างานมากขึน้ แบ่งประเภทของ Extension ต่างๆ ไดด้งันี้ 

โมดลู (Module) เป็นส่วนประกอบทีใ่ชใ้นการแสดงผลในหน้าเวบ็ไซต ์เปรยีบเสมอืนกล่องแต่ละ
กล่อง หรอืเป็นบลอ็กทีส่ามารถแสดงผลตดิต่อกบัผูใ้ช ้โดยโมดลูสามารถก าหนดต าแหน่งการแสดงผลได้ 
           คอมโพเน้นต ์(Component) เปรยีบเสมอืนซอฟแวรท์ีน่ ามาตดิตัง้เสรมิเพื่อรว่มกนัท างานกบั 
Joomla เพื่อเพิม่ความสามารถใหก้บัเวบ็ไซต ์โดยคอมโพเน้นมคีวามซบัซอ้นมากกว่าโมดูล โดยในการ
แสดงผลและส่วนปรบัแต่ง ตอ้งปรบัแต่งการท างานในหน้า Administrator ตวัอยา่งเช่น Photo Gallery, 
Guest Book 
         ปลัก๊อิน (Plug In) เป็นส่วนทีเ่ขา้มาเกี่ยวขอ้งในการตดิต่อระหว่าผูช้มและผูด้แูลเวบ็กบั Joomla 
ปลัก๊อนิสามารถตรวจจบัขอ้มลูทีม่าจาก Joomla ตวัอยา่งเช่น editor – TinyMCE 
         เทม็เพลต็ (Template) คอืส่วนแสดงรปูแบบของขอ้มลูในหน้าเวบ็ไซต ์เช่น รปูรา่งหน้าตา สสีนั 
กราฟฟิก เป็นต้น 

ท่านสามารถ ดาวน์โหลด extension ต่างๆ เพิม่เตมิตามตอ้งการไดท้ีเ่วบ็ไซต์ 
http://extensions.joomla.org/ 

Part 6 :การใช้งาน Extension ต่างๆ  
 

http://extensions.joomla.org/
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ผลลพัธ ์การคน้หา 

 

 

 

ใส่ช่ือ extension ท่ีต้องการค้นหา 

เลือก extension ตามประเภท 

คลิกท่ี extension ท่ีต้องการ 

ค่าใช้จ่ายของ extension 
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ตรวจสอบ extension ก่อนการดาวน์โหลด 

 

เมือ่คลกิปุม่ Download แลว้เมือ่โหลดแลว้เราจะไดไ้ฟล ์extension ต่างๆ เป็น ไฟล ์zip มา 

วิธีการติดตัง้ Extension ใน เทม็เพลต็เวบ็ไซต ์Joomla 

 1. ไปทีเ่มนูส่วนเสรมิ > การจดัการ > ตดิตัง้ 

 

 

 

 

 

แสดงประเภทว่า extension 
น้ีเป็นประเภทใด 

Support กบั Joomla 
version ใด 

ดาวน์โหลด extension 

ดตูวัอย่างการท างาน 
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2. คลกิทีแ่ถบ อพัโหลดแพคเกจไฟล ์ 
3. คลกิทีปุ่ม่ Choose File แลว้ท าการเลอืกไฟลท์ีต่อ้งการตดิตัง้ 
4. จากนัน้คลกิปุ่ม อพัโหลด & ตดิตัง้ 

 

5. จากนัน้รอจนกว่า ขึน้ตดิตัง้ส าเรจ็เรยีบรอ้ยแลว้ 
 6. เมือ่ตดิตัง้แลว้ extension ต่างๆ ทีต่ดิตัง้จะยงัไมถู่กเปิดใชง้าน เราจะตอ้งเขา้ไปเปิดการใชง้าน 
extension ต่างๆ ดว้ยตวัเอง โดยการไปทีเ่มนู ส่วนเสริม > โมดลู (extension บางตวัอาจจะเป็นปลัก๊อนิ 
ดงันัน้ตอ้งคลกิเลอืกเมนู โมดลู > ปลัก๊อนิ) 

7. คน้หาชื่อโมดลูทีต่อ้งการ 

8. คลกิเปลีย่นสถานะกากบาทสแีดง(ปิดการใชง้าน) ของ ส่วนเสรมินัน้ใหเ้ป็นเครือ่งหมายถูก(เปิด
การใชง้าน) 

9. คลกิเขา้ไปในชื่อของส่วนเสรมิ เพื่อเซทค่าต่างๆ ตามตอ้งการ 

         

 

2 

3 

7 

9 
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การติดตัง้ Template (รปูต่างหน้าตาเวบ็ไซต)์ 

Template คอื extension ชนิดหนึ่งของ Joomla เป็นรปูรา่งหน้าตาของเวบ็ไซต ์สามารถดาวน์
โหลดไดท้ัง้แบบฟร ีและไม่ฟร ีสามารถดาวน์โหลดเพิม่เตมิไดท้ี่ เวบ็ไซต ์joomla24.com หรอื คน้หาจาก 
google ว่า template joomla 3 free 
 

 วิธีการดาวน์โหลด Template ในเวบ็ไซต ์Joomla24.com 

 

เมือ่ท าการดาวน์โหลดเรยีบรอ้ยแลว้ ใหท้ าการตดิตัง้เทมเพลตทีด่าวน์โหลด วธิกีารตดิตัง้ เทมเพลต็ 
จะเหมอืนกนัการตดิตัง้ extension ทุกประการ ในหน้าที ่34 

การเปล่ียนเทมเพลต็ (หน้าตาของเวบ็) 
 ไปทีเ่มนูส่วนเสรมิ > เทมเพลต 

 

เวอรช์ัน่ Joomla ท่ีใช้ได ้

ตวัอยา่งเวบ็ไซตเ์มื่อท าเสรจ็แล้ว 

คลิกเพื่อดาวน์โหลด 
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รายละเอยีดหน้าการจดัการเทม็เพลต็(หน้าตาเวบ็ไซต)์  

 

 

การดตู าแหน่งต่างๆ ในระบบเทม็เพลต็ ท่ีจะสามารถวางโมดลูได้ 

ในการจดัวางโมดลูต่างๆ บนเวบ็ไซตน์ัน้ เมือ่เราตดิตัง้เทม็เพลตแต่ละตวัลงไปในระบบ Joomla นัน้ 
แต่ละเทมเพลต จะมตี าแหน่งทีส่ามารถวางโมดลูได ้แตกต่างกนั เราสามารถดตู าแหน่งบนเทมเพลต็ต่างๆ ที่
จะวางโมดลูได ้ดงันี้ 

1. ไปทีเ่มนูส่วนเสรมิ > เทมเพลต 

 

 2. คลกิทีเ่มนูทางซา้ยมอื เทมเพลต 

 

รายช่ือเทม็เพลตท่ีมีใน
ระบบ 

หากเทมเพลต็ใดคลิกดาว
เหลืองหมายถึงใช้งานอยู ่ ประเภทของเทม็เพลต 

2 
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 3. คลกิเพื่อเปิด option ในการดตู าแหน่ง Template ไปที ่ตัง้ค่าพืน้ฐาน (ทางดา้นขวามอื) 

 

 4. คลกิเปิด ในส่วนดตู าแหน่งโมดลู จากนัน้บนัทกึและปิด 

 

5. คลกิทีด่ตูวัอยา่ง 

 
 

3 

4 

5 
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แสดงตวัอย่างต าแหน่งต่างๆ ท่ีจะวางโมดลูได้ 

 

 

การปรบัแต่งค่าต่างๆ ในเทม็เพลต (สีสนั , หวัเวบ็ไซต ์, สีเมนูต่างๆ) 
 1. ไปทีส่่วนเสรมิ > เทมเพลต็ 

 
 
 

รายช่ือต าแหน่งในเทมเพลต็ 
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 2. คลกิไปในชื่อเทม็เพลต็ทีต่อ้งการ 

 
3. คลกิแถบขัน้สงู ท าการเซทค่าและบนัทกึ 

 
** แต่ละเทม็เพลต็มีการเซทค่าไม่เหมือนกนัดงันัน้ เทมเพลต็ตวัท่ีฟรี อาจจะมี option  

ในการเซทค่า น้อยกว่าเทมเพลต็ตวัท่ีเสียเงิน 
 

การสร้าง Module ใหม่ตามต้องการ 

 1. ไปทีเ่มนู ส่วนเสรมิ > โมดลู 

 

2 
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 2. คลกิทีปุ่ม่สรา้งใหม่ 

 
 3. เลอืกประเภทโมดลูตามต้องการ ในทีน่ี่เลอืก ก าหนด HTML เอง 

 
 4. ตัง้ชื่อโมดลู และก าหนดค่าต่างๆ 

 
 

2 

3 

ตัง้ช่ือ โมดลู 
แสดงช่ือ/ซ่อนช่ือโมดลู 

ต าแหน่งท่ีจะวางโมดลู 

พิมพข์้อมูลต่างๆ 

ก าหนดว่าโมดลูจะแสดงท่ีหน้า
ใดบา้ง 
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ผลลพัธ ์

 
 

การวางต าแหน่งโมดลูต่างๆ บนเทมเพลต็ 

เราสามารถน าโมดลูทีต่ดิตัง้แลว้ มาวางบนหน้าเวบ็ไซต์ไดโ้ดยการก าหนดการแสดงโมดลูทีต่อ้งการ 
โดยการก าหนดหนดต าแหน่งของโมดลู มกีฎ งา่ยๆ 3 ขอ้ดงันี้ 
1. ท าการเซทค่าโมดลูหรอืพมิพข์อ้มลูในโมดลูใหเ้รยีบรอ้ย 
2. ท าการตัง้ค่าว่าจะใหโ้มดูลทีต่อ้งการแสดงทีห่น้าเวบ็ใด โดยก าหนดทีแ่ถบ ก าหนดการแสดงทีเ่มนู 
3. ท าการเซทว่าจะใหโ้มดลูทีต่อ้งการไปแสดงต าแหน่งใดของหน้าเวบ็ 
 

1. ไปทีเ่มนู ส่วนเสรมิ > โมดลู 
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2. คลกิเขา้ไปในชื่อของโมดูลทีต่อ้งการเขา้ไปเซทต าแหน่ง 

 
3. คลกิแถบ การก าหนดการแสดงทีเ่มนู เลอืกก าหนดการแสดงผล ว่าจะใหโ้มดลูนี้แสดงทีห่น้าใด 

 

4. เลอืกต าแหน่งทางดา้นขวามอื เลอืกต าแหน่งทีต่อ้งการ 

 

  5. จากนัน้กดปุ่มบนัทกึและปิด 

2 

4 

ช่ือเทมเพลต็ท่ีติดตัง้ 

ต าแหน่งต่างๆ ท่ีอยูบ่นเทม็เพลต 

แสดง/ซ่อน ช่ือโมดลู 

3 
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ผลลพัธ์ 

 

 
การจดัเรียงต าแหน่งของโมดลู 

 ท่านสามารถสลบัต าแหน่งของโมดลูทีอ่ยูใ่นต าแหน่งเดยีวกนัใหเ้รยีงล าดบัตามตอ้งการ 

 1. ไปทีส่่วนเสรมิ > โมดลู 

 

 2. คลกิปุม่เครือ่งมอืคน้หา 

 3. เลอืกต าแหน่งทีต่อ้งการจะเรยีงล าดบัโมดลู 

โมดลูท่ีเซทค่าไว้จะแสดงขึน้ตาม
ต าแหน่งท่ีต้องการ 
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ผลลพัธก์ารคน้หา 

 

 4. คลกิปุม่สญัลกัษณ์การสลบัต าแหน่ง เพื่อใหจ้ดุไข่ปลาหน้าชื่อโมดลูท างาน 

 5. คลกิทีส่ญัลกัษณ์จดุไขป่ลา แลว้ดงึโมดลูขึน้ลงสลบัตามตอ้งการ 

 

 

2 

3 

4 

5 
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วิธีการแก้ปัญหาโมดลูท่ีสร้างติดไปกบัทกุหน้าเพจ  

              การทีเ่ราจะท าขอ้มลูเนื้อหา ใหแ้สดงแต่เนื้อหาของเราเพยีงอย่างเดยีว โดยไม่มโีมดลูอื่นตดิมา
ดว้ย นัน้ เราจะตอ้งท าเมนู เชื่อมโยงเนื้อหานัน้ใหห้มด ซึง่จะเป็นเมนู ดา้นบน หรอื ดา้นขา้งกไ็ด้  
              ในกรณนีี้ เมนูดา้นบน หรอืส่วนของ TOP ดัง้นัน้ ตอ้งสรา้งเมนูเชื่อมโยง ไปยงัเนื้อหาทีก่ าหนด 
แสดงบนเวบ็ไซต ์
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เม่ือ พิจารณาดแูล้วว่า เรามีการเช่ือมโยงไปยงัเน้ือหา ท่ีอยู่ในหมวดหมู่ท่ีแสดงให้เหน็แล้ว เราต้อง

ท า เมนู ในส่วน main menu หรือเมนูด้านข้าง เพ่ือ เช่ือมโยงข้อมลูในหมวดหมู่ของเน้ือหา ท่ีมีการ

เช่ือมโยงไว้ทัง้หมด เพ่ือ ให้ล้ิงคไ์ปยงัข้อมลูนัน้ๆ โดยไม่มีโมดลูติดมาด้วย 

ตวัอย่าง 

 

 

 

 

 

 

 

 

 

 

 

** แต่ไมไ่ดท้ าลงิคห์มวดหมู่ในส่วนเมนูของเวบ็ไซต์ 

โมดลูทีส่รา้งไวม้กีารท าลงิคไ์ปยงัเนื้อหาทีอ่ยูใ่นหมวดหมูข่า่วรบัสมคัรงาน 
แต่ไม่ได้สรา้งเมนูของเวบ็ไซต ์เช่ือมโยงไปยงัหมวดหมู่ขา่วรบัสมคัรงาน 

ผลท่ีได้ คือ มีโมดลู ติดไปทุกหน้า 

เมนูเวบ็ไซต ์

ข่าวรบัสมคัรงาน 
+ ประกาศรบัสมคัรงานเจา้หน้าทีธ่รุการ 
  คลกิเพื่อดรูายละเอยีด>> 

เน้ือหาขา่ว
รบัสมคัรงาน
เจา้หน้าที่
ธุรการ 

โมดลู 

เมนูเวบ็ไซต ์

ข่าวรบัสมคัรงาน 
+ ประกาศรบัสมคัรงานเจา้หน้าทีธ่รุการ 
  คลกิเพื่อดรูายละเอยีด>> 

โมดลู 

รบัสมคัรเจา้หน้าทีธุ่รการจ านวน 1 
อตัรา เงนิเดอืน 15,000 บาท 

ผลทีไ่ด ้
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ถา้มกีารท าเมนูเวบ็ไซตล์งิคไ์ปหาหมวดหมูข่องเนื้อหาทีเ่กบ็อยู่ 

 

 

 

 

 

 

 

 

 

 

 

** และท าลงิคเ์มนูไปยงัหมวดหมูข่องข่าวรบัสมคัรงาน 

สาเหตเุพราะ : ระบบ Joomla นัน้ จะเชื่อมโยงขอ้มลูเนื้อหาทุกอย่างดว้ยเมนู เพื่อใชใ้นการท า Sitemap 
ขอ้มลูเนื้อหาทุกอย่างจะตอ้งเชื่อมโยงผ่านเมนูนัน้เอง หากเราไมไ่ดท้ าเมนูเชื่อมโยงเนื้อหาหรอืหมวดหมู่ ใน
เวบ็มนัจะถอืว่า ขอ้มลูนัน้เชื่อมโยงไมส่มบูรณ์ เลยท าใหม้โีมดลูอื่นตดิไปดว้ย 

ดัง้นัน้เม่ือพิจารณาจากข้อมลูแล้ว เราต้องสร้าง เมนูเช่ือมโยงไปยงัหมวดหมู่ดงัต่อไปน้ี  
1. หมวดหมู่ขา่วประกาศ  
2. หมวดหมู่ขา่วเด่นสหกรณ์  
3. หมวดหมู่จดัซือ้จดัจา้ง  
4. หมวดหมูค่ าสัง่/ประกาศ  
5. หมวดหมูเ่กี่ยวกบัสหกรณ์  
6. หมวดหมูแ่บบฟอรม์และคู่มอื  
7. หมวดหมูเ่วยีนฯ 
 

 

 

 

 

โมดลูทีส่รา้งไวม้กีารท าลงิคไ์ปยงัเนื้อหาทีอ่ยูใ่นหมวดหมูข่า่วรบัสมคัรงาน 
และสรา้งเมนูของเวบ็ไซต ์เช่ือมโยงไปยงัหมวดหมู่ขา่วรบัสมคัรงาน 

ผลท่ีได้ คือ มีโมดลู ติดไปทุกหน้า 

เมนูเวบ็ไซต ์

ข่าวรบัสมคัรงาน 
+ ประกาศรบัสมคัรงานเจา้หน้าทีธ่รุการ 
  คลกิเพื่อดรูายละเอยีด>> 

เน้ือหาขา่ว
รบัสมคัรงาน
เจา้หน้าที่
ธุรการ 

โมดลู 

เมนูเวบ็ไซต ์

รบัสมคัรเจา้หน้าทีธุ่รการจ านวน 1 
อตัรา เงนิเดอืน 15,000 บาท 

ผลทีไ่ด ้
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วิธีการสร้างเมนูลิงคไ์ปยงัหมวดหมู่ 

 

สามารถไปสรา้งเพิม่ ต่อจากเมนู สรปุขา่ว ได้  
การท าเมนูลกู ซ่ึงทุกตวัวิธีการสร้างเหมือนกนั เพียงแค่ต่างท่ีหมวดหมู่ท่ีจะเช่ือมโยงไป  
1. ไปทีค่ าสัง่ เมนู > top เลอืกเพิม่เมนูใหม่  
2. ตัง้ชื่อลงิคต์ามตอ้งการ หรอืตามตวัอยา่ง ใส่เอเลยีส ์ใหส้อดคลอ้งกบัชื่อทีต่ ัง้ 

 
3. เลอืกชนิดเมนู เป็นเน้ือหา > หมวดหมูแ่บบ แสดงแบบลสิรายการ 
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4. เลอืกหมวดหมูข่่าวประกาศ หรอืหมวดหมู่ทีต่อ้งการ 

 

5. ท าการบนัทกึและปิด ท าเพยีงแค่นี้ ขอ้มลูทีล่งิคจ์าก TAB ต่างๆ กจ็ะเชื่อมโยงไปยงัเนื้อหา และไม่ม ี
โมดลูอื่นๆ ตดิมาดว้ย 
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1. Latest News Enhanced 

เป็น extension ทีใ่ชใ้นการแสดงขา่วต่างๆ เช่นขา่วประชาสมัพนัธ ์ข่าวกจิกรรมต่างๆ ของเวบ็ไซต ์
โดย สามารถเซทค่าใหแ้สดงขา่วเองตามวนัหรอืรปูแบบทีต่อ้งการไดอ้ย่างสะดวก สามารถดาวน์โหลด 
extension ไดท้ีเ่วบ็ไซต ์https://extensions.joomla.org/extensions/extension/news-display/articles-
display/latest-news-enhanced 

1.1 เมือ่ดาวน์โหลดเสรจ็แลว้ท าการตดิตัง้ extension โดยไปทีเ่มนู ส่วนเสรมิ > การจดัการ > ตดิตัง้ 
1.2 เมือ่ท าการตดิตัง้ ท าการเปิดการใชง้าน extension ไปทีเ่มนู ส่วนเสรมิ > โมดลู 

 
  

1.3 ท าการเปิดการใชง้าน extension  

 

1.4 คลกิที ่Lastest News Enchanced เพื่อเขา้ไปท าการเซทค่าต่างๆ 

1.5 คลกิทีแ่ถบ Selection 

1.6 Data Source เลอืก Articles 

1.7 Category เลอืกเหมอืนหมูท่ีต่อ้งการแสดง 

เปิดการใช้งาน 

Part 7 :Extension ท่ีน่าสนใจ  
 

https://extensions.joomla.org/extensions/extension/news-display/articles-display/latest-news-enhanced
https://extensions.joomla.org/extensions/extension/news-display/articles-display/latest-news-enhanced
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1.8 หวัขอ้ Max Count ใส่ตวัเลข จ านวนหวัขอ้ทีต่อ้งการแสดงตามตอ้งการ 

 

1.9 คลกิทีแ่ถบ Layout 

 

1.10 เลื่อนสกอลบ์ารล์งดา้นล่าง ดหูวัขอ้ LINKING 

1.11 หวัขอ้ Link on เลอืก Title 

1.6 

1.5 

1.7 

1.9 

1.8 
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1.12 หวัขอ้ Link to เลอืก Item in modal window 

 

 1.13 คลกิทีแ่ถบ Body 

 

 1.14 เลื่อนสกอลบ์ารม์าทีห่วัขอ้ TEXT 

 1.15 หวัขอ้ TEXT introduction เลอืก เป็น Meta Description 

 

 1.16 คลกิทีแ่ถบ การก าหนดการแสดงทีเ่มนู ว่าตอ้งการแสดงทีห่น้าใดบา้ง 

1.10 

1.11 

1.12 

1.15 

1.13 

1.14 
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 1.17 ก าหนดต าแหน่งการแสดงโมดลู ต าแหน่งทีต่อ้งการ 

 

ผลลพัธท่ี์ได้ 

 

 

 

 

1.16 

1.17 
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2. การใช้ Module Anywhere 

 เป็นโมดลูทีเ่ราจะสามารถทีจ่ะแทรก โมดลูต่างๆ ทีเ่ราสรา้งขึน้ หรอืตดิตัง้มาใชง้าน  ลงในหน้า
ขอ้มลูไดต้ามตอ้งการ  
        เราสามารถดาวน์โหลด Extension Module Anywhere ไดท้ี ่
https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-
integration/modules-anywhere ท าการตดิตัง้ extension Module Anywhere ใหเ้รยีบรอ้ย 

วิธีการใช้งาน Module Anywhere 

 2.1 ท าการเปิดเนื้อหาทีต่อ้งการแทรก โมดลู 

 2.2 คลกิทีปุ่่ม Module 

 

 2.3 เลอืก โมดลูทีต่อ้งการแทรก 

 

2.2 

2.3 

https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-integration/modules-anywhere
https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-integration/modules-anywhere
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 2.4 เมือ่ท าการแทรกโมดลูเสรจ็จะมโีค๊ดการแทรกโมดลูเขา้มา 

 

ผลลพัธท่ี์ได้ จะมโีมดลูอื่นแทรกเขา้มาในเนื้อหาทีเ่ราท าการแทรก module เอาไว ้

3. การใช้เคร่ืองมือ TAB 

 สามารถดาวน์โหลดไดท้ี ่https://www.regularlabs.com/extensions/tabs ท าการตดิตัง้ใหเ้รยีบรอ้ย 

เราสามารถใช ้TAB รว่มกนัการแทรกโมดลูต่างๆ เขา้ไปใน TAB ได ้โดยใช ้Module Anywhere 

วิธีการใช้งาน TAB ร่วมกนั Module Anywhere 

 3.1 ไปทีค่ าสัง่ ส่วนเสรมิ > โมดลู 

 3.2 สรา้งโมดลูขึน้มาใหม ่คลกิทีปุ่ม่ สรา้งใหม ่

 

3.3 เลอืก ก าหนด HTML เอง 

 

2.4 

3.2 

3.3 

https://www.regularlabs.com/extensions/tabs
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3.4 ตัง้ชื่อโมดลู ในช่องชื่อ 

 

3.5  คลกิทีปุ่ม่ Tabs อยูท่างดา้นล่าง 

 

3.6 จะปรากฎหน้าการใส่ขอ้มลู TAB 

 

 

 

 

3.4
4 

3.5 
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3.7 ก าหนดค่าต่างๆ ใน TAB ดงันี้ 

 

3.8 เมือ่กรอกขอ้มลูหมดแลว้ คลกิทีปุ่ม่แทรกสเีขยีว 

 

3.9 จะได ้Code ของการแทรก TAB 

 

กรอกช่ือ TABข้อมูล 

คลิกให้ TAB นีเ้ป็น Default 

3.8 

TAB 1 

TAB 2 

TAB 3 
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3.10 ในส่วนของขอ้ความของคุณสามารถแทรก ขอ้ความทีต่อ้งการได ้หรอื แทรก Module ที่
ตอ้งการ หากแทรกโมดลูทีต่อ้งการสามารถแทรกไดด้งันี้ 

 

3.11  คลกิทีปุ่ม่ Tabs อยูท่างดา้นล่าง 

 

3.12 เลอืก โมดลูทีต่อ้งการจะแสดงใน TAB 

 

แทรกโมดลูท่ีต้องการตรงน้ี ท าการ

ลบข้อความออก แล้วคลิกท่ีปุ่ ม 

Module ด้านล่าง 

3.11 

3.11 
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3.13 สครปิของ โมดลูทีจ่ะแทรกจะปรากฏขึน้ 

 

3.14 ท าการเลอืกการก าหนดการแสดงทีเ่มนู เลอืกหน้าทีต่อ้งการแสดง 

 

3.15 เลอืกต าแหน่งใหโ้มดลูทีส่รา้งขึน้ไปแสดงทีต่ าแหน่งใด 

 

3.14 

3.15 
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ผลลพัธท่ี์ได้ 

 

โคด๊การใส่สีให้ TAB ส าหรบั extension Regular TAB 

{tab title="ข่าวประชาสมัพนัธ"์ class="blue"}  

+ ประกาศรบัสมคัรพนกังานราชการ ต าแหน่ง เจา้หน้าทีบ่นัทกึขอ้มลู คลกิรายละเอยีด 
+ ประกาศรบัสมคัรขา้ราชการ ต าแหน่ง นกัวชิาการสหกรณ์ปฏบิตักิาร คลกิรายละเอยีด 
{/tabs} 

วิธีการพิมพ ์Code พิมพค์ าว่า {tab title=”ช่ือแถบท่ีต้องการตัง้” class=”ช่ือสีภาษาองักฤษ”} 
เช่น {tab title=”ข่าวจดัซ้ือจดัจ้าง” class=”red”} 

**สีท่ีสามารถใช้งานได้มีดงัต่อไปน้ี red , yellow , green , blue , gray 
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4. แสดงวิดีโอด้วย AllVideos 

 Allvideos เป็นปลัก๊อนิทีช่่วยใหเ้ราสามารถน าไฟลว์ดิโีอต่างๆ มาแสดงบนเวบ็ไซต์ไดไ้มว่่าจะเป็น
ไฟล ์flv, swf, mov, mp4, wmv ,wma และ Youtube, Google Video ดาวน์โหลดไดท้ี ่
https://extensions.joomla.org/extensions/extension/multimedia/multimedia-players/allvideos  

4.1 วธิกีารใชง้าน ตอ้งท าการ Enable ปลัก๊อนิก่อนใชง้าน โดยไปที่ 

 
       4.2 แกไ้ขส่วน Local Video Floder เป็นทีอ่ยูข่องไฟลV์ideo ทีเ่ราเกบ็ไว ้

 

 4.3. เมือ่เปิดปลัก๊อนิและอพัโหลดไฟลเ์รยีบรอ้ยแลว้ท าการแทรก TAGขอ้มลู หากต้องการใส่ วดิโีอ
ในเนื้อหาใด กท็ าการแทรก Tag code ลงไปในเนื้อหานัน้ 

4.1 

4.2 

https://extensions.joomla.org/extensions/extension/multimedia/multimedia-players/allvideos
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ตวัอย่าง ตอ้งการแทรกไฟล ์Video ประเภท FLV กท็ าการแทรกไปดงันี้ 

{flv}ชื่อไฟลว์ดิโีอ{/flv}     เช่น  {flv}sample{/flv}      

หากเป็น Youtube สามารถแทรกได้ดงัน้ี  

          1. เปิดไฟล ์youtube ทีต่อ้งการน ามาแทรก  copy code รหสั Video มาแทรกในแทก็แสดงวดิโีอ
ดงันี้ 

 

              2. ท าการพมิพข์อ้ความลงในเนื้อหาทีต่อ้งการแสดง 

 

{youtube}Qcly9NiNbmo{/youtube}  
หรอื {youtube}Qcly9NiNbmo|660|450|1{/youtube} 

หมายความว่า แสดง youtube ไฟลน์ี้ โดยมขีนาดกวา้ง 660 pixel และสงู 450 pixel และ 1 คอืเล่นอตัโนมตั ิ

1 

2 
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ผลลพัธ์ 

 

 

5. Module นับจ านวนผูเ้ข้าเยี่ยมชมเวบ็ไซต ์Vinaora Visitors Counter 

 5.1 ดาวน์โหลด Module Vinaora Visitor Counter  แลว้ท าการตดิตัง้ใหเ้รยีบรอ้ย ดาวน์โหลดไดท้ี ่
https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-
counter  

 
         5.2 ท าการเปิด Module ทีต่ดิตัง้โดยการไปที ่ส่วนเสรมิ -> โมดลู 

         5.3 คลกิเขา้ไปตัง้ค่าที ่Vinaora Visitor Counter ท าการเซทค่าตามตอ้งการ 

5.1 

https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-counter
https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-counter
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           5.4 ท าการเลอืกต าแหน่งทีต่อ้งการแสดง Module นี้ 

 

        5.5 ท าการก าหนดการแสดง Moduleทีห่น้าใดบา้ง 

 

ผลลพัธ์ 

 

ผลลัพธ์ 

5.3 

5.4 

5.5 
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6. ส าหรบัท าภาพสไลด ์ด้วย Extension DJ-imageSlider   

 1. เขา้เวบ็ไซต ์https://dj-extensions.com/dj-imageslider จากนัน้ คลกิ download 

 

        2. ท าการตดิตัง้ Module DJ- ImageSlider ใหเ้รยีบรอ้ย 

        3. จากนัน้เขา้ไปจดัการ Module ทีต่ดิตัง้ ไปที ่ส่วนเสรมิ -> โมดลู 

 
 
       4. ท าการเปิดการใชง้าน DJ-imageSlider 

 

 

 

 

 

1 

3 

4 
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เร่ิมสร้างสไลด ์

5. ท าการสรา้งหมวดหมู่ของสไลด ์สามารถสรา้งโดยไปที ่คอมโพเน้นท-์> DJ-ImageSlider > Catagories 

 

            6.ท าการสรา้ง Category ของสไลด ์ทีต่อ้งการ คลกิที ่Category 

 

7. คลกิปุม่ New เพื่อสรา้ง Category ใหม ่

 

8. ตัง้ชื่อ Category ทีต่อ้งการใส่เอเลยีส ์ 9.คลกิ Save&Close 

 

6 

8 

9 
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10. คลกิที ่Slide เพื่อเพิม่รปูภาพท า Slide คลกิปุม่ New 

 

11. ท าการตัง้ชื่อ Title เลอืก Category และ เลอืกรปูที ่Slide Image โดยการกดปุ่ม Select 

 

12. คลกิเลอืกรปู หากยงัไม่มรีปูทีต่อ้งการ คลกิปุ่ม เริม่อพัโหลด เมือ่อพัโหลดรปูเสรจ็เรยีบรอ้ยแลว้คลกิปุม่
เพิม่ในเนื้อหา 

 

 

10.1 

11.1 

11.2 

11.3 

12.1 12.2 

12.3 

10.2 
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13. ตอ้งการท าลงิคเ์ลอืก Link type และใส่ URL address ทีต่อ้งการ 

 

14. เมือ่เสรจ็แลว้ คลกิ Save&Close 

 
15. ภาพสไลดก์จ็ะปรากฎ หากตอ้งท าเพิม่กท็ าตาม ขอ้ 11 ได ้

 
ท าการเซทค่าในการแสดงโมดลู Dj-image slideshow 

1. ไปทีเ่มนู ส่วนเสรมิ > โมดลู  
2. คลกิที ่DJ-ImageSlider 
3. Slide Source เลอืก Component 

   

13 

14 

15 

เลือก Component 

เลือก รปูแบบ Slide Type 

เลือก Link Images 
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ให้น ารปูจากโฟลเดอรใ์ดมาแสดง 

เลือกจาก Category ท่ีต้องการ 

ขนาดของสไลดเ์ตม็พื้นท่ีหรือไม่ 

เซทความกว้างตามต้องการ 

ให้แสดงทีละก่ีรปูในสไลด ์

จ านวนสงูสดุแต่ละสไลด ์

เล่นอตัโนมติัหรือไม่ 

การหยดุและเล่นแบบใด 

images 
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4. คลกิทีแ่ถบก าหนดการแสดงทีเ่มนู ว่าจะใหแ้สดงทีห่น้าใดบา้ง 

 

5. ท าการเซทค่าเพิม่เตมิ และต าแหน่งทีจ่ะแสดงบนเวบ็ไซต์ 

 

ผลลพัธ์ 

 

 

 

เลือกต าแหน่ง
แสดงผล 

DJ-image Slider 
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7. Extension Fast Social Share Botton 

       1. ดาวน์โหลด Plugin Fast Social Share ไดจ้าก 
http://storejextensions.org/extensions/fast_social_share.html แลว้ท าการดาวน์โหลดและตดิตัง้ 

 

2. ท าการคลกิเขา้ไปเพื่อเปิดการท างาน Plug In โดยไปที ่ส่วนเสรมิ -> การจดัการปลัก๊อนิ 

 

      3. คลกิเพื่อเปิดปลัก๊อนิใหท้ างาน  
      4. จากนัน้คลกิไปทีป่ลัก๊อนิเพื่อเขา้ไปเซทค่า 

           

                      

1 

3 4 

http://storejextensions.org/extensions/fast_social_share.html


คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 93 
 
        5. ท าการเซทค่าต่างๆ ตามตอ้งการ 

 

      6. ในส่วน FB ShareMe Button ท าการ Set เป็น Show    7.จากนัน้คลกิ Save 

 

5 

5 

6 

7 
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8. เรยีกใชป้ลัก๊อนิโดย เปิดเนื้อหาทีต่อ้งการ จากนัน้พมิพค์ าว่า  {fastsocialshare}

 

ผลลพัธท่ี์ได้ 

 

 

8 
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8. ท า Gallery รปูภาพ ด้วย Extension Simple Images Gallery      

1. คลกิดาวน์โหลด http://extensions.joomla.org/extensions/extension/photos-a-
images/galleries/simple-image-gallery และท าการตดิตัง้ 

 
2.ท าการเปิดใชง้าน Plug In ทีต่ดิตัง้ ไปที ่ส่วนเสรมิ -> การจดัการปลัก๊อนิ 

  
3. คลกิเปิดใชง้านปลัก๊อนิ Simple Image Gallery    4. คลกิเขา้ไปแกไ้ข 

 
 

1 

3 4 

http://extensions.joomla.org/extensions/extension/photos-a-images/galleries/simple-image-gallery
http://extensions.joomla.org/extensions/extension/photos-a-images/galleries/simple-image-gallery
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          5. เลอืก ไฟลเ์ดอรท์ีต่อ้งการแสดงรปู Gallery และเซทค่าต่างๆ 

 
           6. เปิดเนื้อหาทีต่อ้งแทรก Gallery รปูภาพ    
           7. แทรก tag ลงไปดงันี้ {gallery}ช่ือโฟลเดอรร์ปู{/gallery}  เช่น  {gallery}slider{/gallery} 

 

 

5 

5 

6 
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ผลลพัธ์ 
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9. การท าแผนผงัเวบ็ไซต ์Sitemap 

** การท า Site Map อาจจะมบีางส่วนทีผู่บ้รหิารเวบ็ไซตต์อ้งจดัการเรยีงขอ้มลูเองในบางส่วน  
1. ท าการตดิตัง้ extension OS map Free  
2. โดยไปที ่เมนูส่วนเสรมิ > การจดัการ > ตดิตัง้ ท าการตดิตัง้ Extension Os map Free 

 

3. เปิดการท าการ Plug In Os map Free 

 

4. ไปทีเ่มนู คอมโพเน้นท ์> OSMap Free 

 

 

3 
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5. คลกิทีปุ่ม่ สรา้งใหม ่

 
6. ท าการตัง้ชื่อใน ช่อง Name และท าการคลกิเลอืก กลุ่มเมนู ทีต่อ้งการท า Sitemap จากนัน้  
กดปุม่ บนัทกึและปิด 

 

7. คลกิค าว่า html เพื่อดตูวัอยา่ง Sitemap 

 

8. จะเปิดหน้าเพจทีเ่ป็น sitemap ใหเ้รา 

 

5 

6.3 

6.1 

6.2 

7 
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9. ท าการไฮไลท ์Sitemap ทีไ่ดแ้ละ copy 

 

10. ท าการสรา้งเนื้อหาขึน้ใหม ่เพื่อวางขอ้มลู Sitemap ที ่copy มา และท าการแก้ขอ้มลูโดย การเรยีงขอ้มลู
ตามหวัขอ้ทีต่อ้งการ 

 

12. ท าการสรา้งเมนู ลงิคไ์ปยงัเนื้อหา ทีเ่ป็นแผนผงัเวบ็ไซตต์ามตอ้งการ หากมกีารเปลีย่นลงิค ์เมนูใหม ่ 
กท็ าการสรา้งลงิคs์itemap ใหม ่ตามขอ้ 5 
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10. การท า Popup ก่อนเข้าเวบ็ไซต์ ด้วย JH Splash Screen 

1. ท าการตดิตัง้ปลัก๊อนิ JH Splash Screen 

2. ท าการเปิดปลัก๊อิน JH Splash Screen ท างาน 
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ผลลพัธ์ 

 

 

11. การสร้าง Webboard ด้วย Kunena 

** ในการใชร้ะบบเวบ็บอรด์นัน้ เพื่อความปลอดภยัของเวบ็ไซตจ์ะตดิตัง้ extension ทีป้่อง Spam ต่างๆ ที่
จะเขา้ มาก่อกวนเวบ็ไซต ์ 
** ระบบเวบ็บอรด์นัน้ จะมกีารเกีย่วขอ้งกบัระบบสมาชกิของเวบ็ไซต ์ทีเ่ป็นผูด้แูลเวบ็ไซตซ์ึง่เป็นผูด้แูลเวบ็
บอรด์ การตดิตัง้ extension Kunena ท่านสามารถดาวน์โหลด Extension ไดท้ี ่เวบ็ไซต ์
http://web.cpd.go.th/webfaq โดยท าการตดิตัง้ ตวัเวบ็บอรด์ และ ตดิตัง้ภาษาของเวบ็บอรด์  
 
1. ไปทีค่ าสัง่ส่วนเสรมิ > จดัการ > ตดิตัง้  ท าการตดิตัง้ใหเ้รยีบรอ้ย 
2. เมือ่ท าการตดิตัง้ส าเรจ็เรยีบรอ้ยแลว้ ไปที ่ค าสัง่ คอมโพเน้นท์ > ระบบฟอรัม่ Kunena > แดชบอรด์  
เพื่อเป็นการเขา้สู่หน้าหลกัระบบเวบ็บอรด์ 
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3. คลิกท่ีหมวดหมู่ 

 
4. ท าการเพิม่หมวดหมูห่รอืแกไ้ขหมวดหมู่ทีต่อ้งการ 

 

5. หากตอ้งการสรา้งหมวดหมูใ่หม ่ใหค้ลกิปุม่หมวดหมู่ใหม ่สเีขยีว 
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6. ท าการก าหนดชื่อหมวดหมูแ่ละรายละเอยีด และท าการบนัทกึและปิด 

 

7. หากตอ้งการลบหมวดบางหมวดทีไ่มต่อ้งการออก ใหท้ าการติก๊ถูกดา้นหน้าหมวดทีไ่มต่อ้งการ แลว้ คลกิ
ทีปุ่ม่ลบ 
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8. จะไดห้มวด ทีเ่ราสรา้งใหม ่จากนัน้ท าการคลกิเขา้ไปในหมวดหมูท่ีเ่ราสรา้งขึน้ 

 

9. ก าหนดค่า ทีแ่ถบ การเขา้ถงึหมวดหมู่ 
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10. คลกิทีแ่ถบ การตัง้ค่าหมวดหมูก่ าหนดค่าดงัต่อไปน้ีจากนัน้กดปุ่ม บนัทกึและปิด 

 

11. ก าหนด ผูใ้ช ้ทีจ่ะดแูลระบบเวบ็บอรด์  
         11.1 คลกิทีเ่มนูผูใ้ชง้าน ทางดา้นซา้ยมอื  
         11.2 คลกิทีช่ื่อผูด้แูลระบบทีต่อ้งการ 

 

 

11.1 

11.2 
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          11.3 คลกิทีแ่ถบ การตัง้ค่าในส่วนเป็นผูด้แูลฟอรัม่ เซทค่าตามรปูคอื ให ้แอดมนิคนน้ี ดแูลทุก 
หมวดหมู ่หากตอ้งการเลอืกบางหมวดกค็ลกิทีช่ื่อหมวดหมูท่ีต่อ้งการ 

 

             11.4 ท าการกดปุ่ม บนัทกึและปิด 

12. คลกิทีเ่มนูทางซา้ยมอื ตัง้ค่าคอนฟิก  
                12.1 ก าหนดขอ้มลูตามตอ้งการ หรอืตามตวัอยา่ง 
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               12.2 คลกิทีแ่ถบความปลอดภยั ก าหนดค่าดงัต่อไปนี้ 

 

                      12.3 ท าการบนัทกึและปิด  
 
13. ท าการสรา้งเมนู เพื่อเชื่อมโยงไปยงัเวบ็บอรด์  
                    13.1 ไปที ่ค าสัง่ เมนู > Main Menu > เพิม่เมนูใหม่ 
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                   13.2 ตัง้ชื่อเมนู เวบ็บอรด์ และตัง้ เอเลยีส ์webboard 

 

                 13.3 เลอืกชนิดของเมนู เป็น ระบบฟอรัม่ kunena 

 

              13.4 เลอืกรายการหลกั เป็น ฟอรมั จากนัน้กบ็นัทกึและปิด 
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              13.5 จะไดเ้มนู เวบ็บอรด์ขึน้มาเมือ่คลกิแลว้จะเขา้มาสู่หน้าหลกัของเวบ็บอรด์ 

 

                13.6 สามารถตัง้กระทูไ้ดโ้ดยคลกิทีปุ่่ม ตัง้กระทูใ้หม่ 
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           13.7 ตัง้กระทูต้ามตอ้งการ เมือ่เสรจ็เรยีบรอ้ยแลว้กดปุม่ ส่งขอ้ความ 

 

        13.8 กระทูจ้ะเขา้สู่ระบบ แต่ยงัไมป่รากฏทีห่น้าเวบ็ไซต ์เพราะ ผูด้แูลระบบจะท าการอนุมตัขิึน้ก่อน 
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ผูด้แูลเวบ็บอรด์ เข้าสู่ระบบเวบ็บอรด์ เพ่ือ อนุมติักระทู้ 

1. คลกิเข้าสูร่ะบบ เพื่อลอ็กอินเข้าสูร่ะบบ 

 

2. เมือ่ลอ็กอนิเขา้สู่ระบบ จะเหน็ กระทูท้ีร่อการอนุมตั ิสามารถคลกิเขา้ไปดขูอ้มลูได้ 
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3. เมือ่เขา้มาดแูลว้ หากตอ้งการลบขอ้มลูบางส่วน คลกิทีก่ารดูแล และเลอืกลบ 

 

4. ท าการ ติก๊เลอืกกระทูท้ีต่้องการ อนุมตั ิหรอืลบกระทู ้แลว้คลกิเลอืก ว่าจะจดัการอยา่งไร 
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5. เมือ่มกีารอนุมตัแิลว้กระทูไ้ปปรากฏบนเวบ็บอรด์แลว้ หากมคีนเขา้มาตอบในกระทูท้ีอ่นุมตัแิลว้ ผูด้แูล
เวบ็บอรด์ ท าการลอ็กอนิเขา้ไปอนุมตัคิ าตอบไดด้งันี้  
             5.1 ท าการคลกิเขา้ไปในกระทูน้ัน้  
             5.2 ดา้นล่างขอ้ความทีต่อบ คลกิการดูแล เลอืก ตรวจสอบผ่านอนุญาตใหน้ าเสนอ 

 

การออกจากระบบ ผูด้แูลเวบ็บอรด์ 
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12. การป้องกนัเบือ้งต้นส าหรบัเวบ็ไซต ์โดยใช้ JH Guard 

           JH Guard เป็น ปลัก๊อนิ ป้องกนัการ Hack เวบ็ไซตเ์บือ้งตน้ สามารถดาวน์โหลดไดท้ี ่
https://extensions.joomla.org/extension/jhackguard/ เมือ่ดาวน์โหลดแลว้ท าการตดิตัง้ปลัก้อนิ JH Guard 
ใหเ้สรจ็เรยีบรอ้ย 

วิธีการตรวจสอบ  

1.ไปทีเ่มนู ส่วนเสรมิ > ปลัก๊อนิ 
2. คน้หาค าว่า jh ในช่องคน้หา 
3. ท าการเปิดการใชง้าน Extension JHackGuard Plugin ใหเ้ป็นเครือ่งหมายถูก (เปิดการใชง้าน) 

 

 
13. เช่ือมโยง Social Network ด้วย BT Facebook LikeBox 
                 ในปจัจบุนัการท าเวบ็ไซต์จะตอ้งมกีารประชาสมัพนัธค์วบคู่กบัสื่อออนไลน์ ซึง่สื่อออนไลน์ที่
นิยมในปจัจบุนัคอื Facebook ดงันัน้เราจะตอ้งท าการสรา้ง Facebook FanPage ขึน้มา เพื่อเผยแพรข่อ้มลู
ขา่วสารควบคู่กบัการท าเวบ็ไซตไ์ปดว้ย 

 

 

 

 

 

1. 2. 

3. 

https://extensions.joomla.org/extension/jhackguard/
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วิธีการสร้าง Facebook FanPage 

1. ท าการลอ็กอนิเขา้สู่เวบ็ไซต ์Facebook  
2. คลกิทีปุ่ม่สรา้ง เลอืก เพจ 

 

3. เลอืกประเภทของเพจทีต่อ้งการ 

 

2.1 

2.2 

3 
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4. ตัง้ชื่อเพจ และหมวดหมูเ่พื่อใส่ค าอธบิายเพจทีเ่ราสรา้งขึน้ และกดปุม่ด าเนินการต่อ 

 

 

5. เพิม่รปูโปรไฟล ์ของแฟนเพจ 
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6. เพิม่รปูหน้าปก แฟนเพจ 

 

7. จะไดห้น้า Facbook Fanpage ขึน้มา 

 
 

8. ใหท้ าการ copy URL ของแฟนเพจ เพื่อใชท้ า Facebook Likebox 

 
 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 120 
 
9. ท าการตดิตัง้ extension BT Facebook LikeBox  สามารถดาวน์โหลดไดท้ี ่
https://extensions.joomla.org/extension/bt-facebook-like-box/ 

10. เมือ่ท าการตดิตัง้แลว้ ท าการไปเซทค่า ใน BT Facebook LikeBox โดยไปที ่ค าสัง่ ส่วนเสรมิ เลอืก 
โมดลู 

 

11. คลกิทีแ่ถบ การก าหนดการแสดงทีเ่มนู ก าหนดการแสดงผล เป็น เฉพาะหน้าทีเ่ลอืก  
เลอืกเฉพาะ หน้าหลกั 

ใส่ URL ของ แฟนเพจท่ี Copy มา 

ใส่ความกว้างและความสูง 

แสดงรปูเพื่อนท่ีเคยกด Like แฟนเพจหรอืไม ่

จ านวนรปูเพือ่นท่ีเคยกด Link แฟนเพจ 

https://extensions.joomla.org/extension/bt-facebook-like-box/
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12. ทางดา้นขวามอื ในส่วนต าแหน่ง เลอืกเป็นทางขวาของหน้าเวบ็ คอื ต าแหน่ง Right Position 7  ใน 
เทมเพลต็ Protostar 

  

13. ท าการบนัทกึและปิด 

14. จะได ้Facebook Likebox แฟนเพจทีก่ าหนดแสดงอยูท่างดา้นขวา 

 

เลือกต าแหน่งท่ีต้องการ 

เลือกเฉพาะหน้าหลกั 
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การบริหารการจดัการไฟลข้์อมลูบนเวบ็ไซต์ 

 1. คลกิทีส่ญัลกัษณ์ Joomla 
 2. คลกิ มเีดยี 

 

สร้าง โฟลเดอรใ์หม่ 

 

 

Part 8 : เทคนิคต่างๆ  
 

1 

2 

คลิก 

ตัง้ช่ือโฟลเดอร ์

คลิกปุ่ มสร้างโฟลเดอร ์
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อพัโหลดไฟล ์

 

การลบไฟล ์

 

**การลบโฟลเดอรนั์น้จะต้องลบไฟลท่ี์อยู่ภายในก่อนจึงจะลบโฟลเดอรไ์ด้ 

 

 

 

 

คลิก 

คลิกปุ่ ม Choose Files 

คลิกปุ่ มเร่ิมอพัโหลด 

คลิกเลือกไฟลท่ี์ต้องการ 

คลิกปุ่ มลบ 
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วิธีการอพัโหลดไฟลท่ี์มีขนาดใหญ่และไม่สามารถอพัโหลดขึ้นในระบบได้ 

 ในการอพัโหลดไฟลท์ีม่ขีนาดใหญ่นัน้ทางระบบ Joomla นัน้จะอนุญาต ใหท้่านอพัโหลดไฟลไ์ดไ้ฟล์
ละไมเ่กนิ 2 mb หากไฟลน์ัน้มขีนาดเกนิ 2 mb ขึน้ไปต้องท าการอพัโหลดขึน้ google drive ของส านกังาน 

 วิธีการใช้ google drive  

 1. เขา้เวบ็ไซต ์google.co.th 

 

2. ท าการลอ็กอนิเขา้สู่ระบบ 

 

3. ท าการคลกิทีส่ญัลกัษณ์ เปิดแอป  
4. จากนัน้คลกิที ่Drive 

1 
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5. จะเขา้มายงัไดรฟ์ของเรา ท าการคลกิปุม่ New เพื่อท าการอพัโหลดไฟลใ์หม่ 

 

 

 

 

3 
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5 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 126 
 
6. เลอืก File upload และท าการเลอืกไฟลท์ีต่อ้งการ 

 

7. รอจนกว่าอพัโหลดเสรจ็สิน้ 

 

8. เมือ่อพัโหลดเสรจ็สิน้ตอ้งการน าไฟลม์าใชง้าน เราจะตอ้ง copy ลงิคไ์ฟลใ์น google drive โดยการคลกิ
ขวาที ่ไฟลท์ีต่อ้งการ 

9. เลอืก Get Shareable link 

 

6 
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10. ท าการ copy ลงิคไ์ฟลท์ีไ่ด ้ไปท าการเชื่อมโยงไฟลใ์นเวบ็ไซต์ 

 

 

การท าให้เวบ็ไซตค้์นหาเจอบนเวบ็ไซต์ Google 

          การท าเวบ็ไซต์ทีเ่ราสรา้งขึน้ คน้หาเจอบน google นัน้ เราจะตอ้งมกีารท า SEO (Search Enging 
Optimization) ใหก้บัเวบ็ไซตข์องเรา เพื่อให ้google รูจ้กักบัเวบ้ไซตข์องเรา 

           การท า SEO ใน Joomla จรงิๆแลว้มนักไ็มไ่ดต่้างอะไรกบัการท า SEO ทัว่ๆไป คอืมาจากพืน้ฐาน
เดยีวกนั แต่สิง่ทีแ่ตกต่างกค็อื วธิกีารตัง้ค่า SEO ของ Joomla ต าแหน่งทีเ่ราตอ้งใส่คยีเ์วริด์  
 
พื้นฐานทุกเวบ็ ท่ี Google อยากให้มี 

– บทความทีไ่ม่ซ ้าใคร หรอื Unique และ ขอ้มลูเกีย่วกบัผูเ้ขยีน หรอื meta data 
– ไฟลโ์รบอท หรอื Robot.txt 
– SEF URLs หรอื Search Engine Friendly URLs การม ีURL ทีเ่ป็นมติร 
– ม ีSitemap ของเวบ็ 

พื้นฐานทุกเวบ็ ท่ี Google บอกว่า ควรหลีกเล่ียง 

– การม ีKeywords มากเกนิไป ท าใหกู้เกลิไม่ชอบนะ 
– การมคีอนเทนต ์หรอืบทความทีซ่ ้ากบัคนอื่น หรอื Duplicate 
– มลีงิคเ์สยีบนเวบ็ 
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วิธีการท า SEO มีดงัน้ี 

1. ใส่ค าคน้หาและค าอธบิายเวบ็ ในส่วนของตัง้ค่าระบบหลกั 

 

2. ทุกๆ รายการของเมนู ควรม ีรายละเอยีด ทีม่คีวามเป็นเอกลกัษณ์ หรอืไมซ่ ้ากบัหน้าใด วธิใีส่ ใหไ้ป
ที ่เมนู > Main menu > เลอืกแต่ละเมนู   แลว้ไปที ่ตัง้ค่าเมตะดาตา้ แลว้ก าหนด รายละเอยีด และ 
ค าส าคญั 
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ผลลพัธม์นัจะไปแสดงบน Google เวลามคีนคน้หาค าทีเ่กีย่วขอ้งกบัทีไ่ดต้ัง้ไว ้ยิง่เราอธบิายด ีกจ็ะยิง่
ไดเ้ปรยีบ ใน รายละเอยีด ควรม ีค าส าคญั ประกอบอยูด่ว้ย และทีส่ าคญั เราตอ้งก าหนด title ของแต่ละเมนู
หรอื แต่ละหน้าเพจอกีดว้ย เหมอืนรปูดา้นล่าง 

 

ท า SEO แล้ว ท าไมยงัไม่เจอเวบ็ไซต์บน google 

             การทีเ่วบ็ของท่านจะตดิอนัดบัการคน้หาเจอนัน้ google จะมรีะบบ bot หรอื spider คอยไปเกบ็
ขอ้มลูตามเวบ็ต่างๆ และจะใหค้ะแนนกบัเวบ็ท่าน โดยจะมกีารใหค้ะแนน นัน้ตวัระบบ ของgoogle ทีช่ื่อว่า 
แพนดา้ และ เพนกวิน้ เป็นคนวเิคราะหเ์วบ็ของท่าน 

ค าถามท่ีพบบ่อย 

1. เราจะท า seo บนเวบ็ใหเ้จอเลยนัน้ ปจัจยัทีจ่ะให ้google เจอเวบ็เรามอีะไรบา้ง 

ตอบ ค าส าคญั ค าอธบิายเวบ็ ขอ้ความหวัขอ้ตวัเน้น  เนื้อหา  ภาพ สถติคินเขา้เวบ็ การประชาสมัพนัธเ์วบ็
ผ่าน social ฯลฯ ถา้สิง่เราไมม่บีนเวบ็ ไมเ่จอแน่นอน ค าส าคญัใส่แค่อนัเดยีว กจ็ะเจอเวบ็ยากขึน้ 

2. สรา้งเวบ็แลว้เปิดเวบ็แลว้ จะเจอ บน google เลยหรอืไม่ 

ตอบ ไมเ่จอครบั ตอ้งท าคะแนนใหเ้วบ็ไซตต์ดิอนัดบัถงึจะเจอ 

3 ถา้เปิดเวบ็มาอยากใหเ้จอท ายงัไง 

ตอบ จ่ายเงนิให ้google  
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4. แลว้นานแค่ไหนจะเจอถา้ไมจ่่ายเงนิ 

ตอบ ขึน้อยูก่บัคะแนนของเวบ็ทีท่่านได ้ว่าท า seo เวบ็ไดด้เีพยีงใด ตอบไมไ่ดว้่าจะใชเ้วลานานเท่าไหร ่
บางเวบ็อาจจะไมข่ึน้เลย เพราะคะแนนต ่า  

แต่ตอ้งบอกไวก่้อนว่า การท า seo แบบฟร ีท าได ้แต่ผลจะชา้ เพราะของฟรไีม่มใีนโลก เพราะ google เป็น
องคก์รแสวงหาก าไร ทางทีท่ า seo ฟร ีgoogle จะพยายามปิดไว ้

5. แลว้จะท า seo บนเวบ็ไดอ้ยา่งไรบา้ง 

ตอบ มหีลายวธิมีากมายในการท า สามารถคน้หาใน youtube มวีดิโีอการสอนเป็นจ านวนมาก 

 

การปิด อพัเดท Extension และเวอรช์ัน่ Joomla 
           ระบบเวบ็ไซต ์Joomla นัน้จะมกีารอพัเดทอยูเ่สมอ ดงันัน้การอพัเดทเวอรช์ัน่ หรอื Extension 
ต่างๆ นัน้ หากท าการอพัเดทโดยไมท่ าการ Backup ส ารองขอ้มลูไว ้เมือ่อพัเดทไปแลว้ อาจจะท าให้
เวบ็ไซตไ์มส่ามารถใชง้านได ้ดงันัน้จงึตอ้งระวงัการอพัเดทเหล่านี้  
           แต่หากท่านตอ้งการปิดปุ่มอพัเดทเหล่าน้ีเพื่อป้องกนัการกดปุม่อพัเดทนัน้สามารถปิดไดด้งัน้ี 
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1. ไปทีเ่มนู ส่วนเสรมิ > การจดัการ > อพัเดทเวบ็ไซต ์

 

2. ท าการคลกิเลอืก extension ทีต่อ้งการปิด หรอืคลกิปุ่ม เลอืกทัง้หมด  
3. กดปุม่ ปิด 
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ปิดการอพัเดทแล้ว ยงัขึ้นแสดงการ อพัเดทอีก ให้กดไปท่ีปุ่ ม view Update 

 

 
** การอพัเดทกจ็ะไม่ปรากฏอีก หาก ยงัขึ้นอีก กท็ าการตรวจสอบว่าปิดการ อพัเดท จากเมนู ส่วน
เสริม >การจดัการ > อพัเดทไซต ์แล้วหรือยงั 
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ส่วนประกอบต่างๆ ของหน้าจอของโปรแกรม Photoshop 

 

 

 

 

Title Bar แสดงช่ือ Program 

Menu Bar การใช้งานค าสัง่ตา่งๆ 

Option Bar จะเปลีย่นตาม Tool ที่เลอืก 

Tool เคร่ืองมือการใช้งาน 

Windows ที่ถกูซอ่น 

Windows เคร่ืองมือตา่งๆ 

วิธีการใช้ History ย้อนกลบัการกระท าที่ผิดพลาด สามารถเลือ่นกลบั

ได้โดยคลกิย้อนกลบัขึน้ไปทีละการกระท าตามต้องการ แตก่าร

ย้อนกลบั History มีข้อจ ากดัคือ ย้อนกลบัได้ไมม่า ดงันัน้การท างาน

กบัโปรแกรม Photoshop ควรระมดัระวงัในการท างาน 

Part 9 : คู่มือการท าหวัเวบ็ไซตแ์ละการตกแต่งภาพเบือ้งต้น โดย Photoshop 

 
 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 134 
 

วิธีการท าหวัเวบ็ไซต์ 

1. สร้างพื้นท่ีการท างาน เพ่ือสร้างหวัเวบ็ไซต ์โดยไปค าสัง่ File > New  หรือ Ctrl+N 

 

 

2. ก าหนดพื้นท่ีการท างานท่ีจะสร้างส่วนหวัของเวบ็ไซต ์โดยก าหนดขนาดตามตวัอย่าง แล้วกดปุ่ ม 
OK 

 

1. 

ก าหนดขนาดต่างๆ หน่วยเป็น pixels 
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3. จะได้พื้นท่ีการท างานท่ีเราก าหนดข้ึนโดยมีรายละเอียดดงัน้ี 

 

4. ท าการลงสี โดยการไล่ระดบัสีท่ีต้องการโดยใน Tool Gradiant  (ถกูซ่อนอยู่ใน Tool สญัลกัษณ์ รปู
ถงัสี) 

 

 

แถบสลับชื่อไฟล์ต่างๆ ที่ท างานอยู่ 

พืน้ที่การท างาน 
Layer การท างาน 

4.1 ท าการคลกิเลอืก Tool 

Gradient Tool 

 

4.2 ท าการคลกิเลอืกสี 
Foregroud color และ 

Background color 

 

4.3 ท าการคลกิสทีี่ต้องการ
ทัง้ Foreground และ 

Background 
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5. เลือก Option Bar ตามความต้องการ 

 

 

6. ท าการคลิกค้าง จดุเร่ิมต้นแล้วลากให้เกิดเส้น 

 

 

7. ท าการพิมพข้์อความลงพื้นท่ีการท างาน โดยใช้ Type Tools 

                     

 

5.1 เลือกแบบสกีารไล่ระดับที่ต้องการ 

 

5.2 เลือกลกัษณะการไล่ระดับสี 

 

5.3 เลือก Mode การท างาน Normal 

 

6.1 จุดเร่ิมต้น 

 

6.2 จุดสิน้สุด 

 

ผลลัพธ์ 

 

คลิกที่ Type Tool 

 

คลิกเมาส์ให้เกิด Cursor ตรงจุดที่ต้องการ ให้เกิด 
Cursor กระพริบๆ 
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8. พิมพข้์อความท่ีต้องการลงพื้นท่ีการท างาน 

 

 

 

9. ท าการใส่ Effect ให้กบั Layer ตวัอกัษรให้ดเูด่นขึ้นโดยการใส่เส้นขอบตวัอกัษร  
โดยไปท่ีเมนู Layer> Layer Style>Stroke 

 

 

ได้ Layer ของชื่อ
หน่วยงาน 

 

9.1 ไปที่  
Layer>Layer Style>Stroke 

 

9.2 ขนาดของเส้นขอบ 

 
9.3 สีของเส้นขอบ 

 

แบบอักษร 

 

หนา/เอียง 

 

ขนาด 

 

จัดวาง 

 

สี 

 

ข้อความศิลป์ 

 

ยนืยนั 

 

ความคมชัด 
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10. ท าการย้ายข้อความไปยงัต าแหน่งท่ีต้องการโดยใช้ Move Tool หรือ arrow key (ลกูศรบนแป้น

ลกูศรบนคียบ์อรด์เล่ือนข้อความได้) 

 

11. ท าการเปิดไฟลต์ราสญัลกัษณ์ท่ีต้องการเข้ามายงัโปรแกรม Photoshop โดยไปท่ีค าสัง่  

File > open หรือ CTRL+O 

 

9.3 เงาของตัวอักษร (Drop Shadow) 

 

11. เปิดไฟล์ภาพท่ีต้องการ  
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12. ได้ไฟลร์ปูท่ีต้องการจากนัน้เลือก เครื่องมือ Selection เพ่ือท าการเลือกบางส่วนของรปูภาพไป

ยงัพื้นท่ีการท างานของเรา 

 

 
 

11.1 เลือกรูปท่ีต้องการแล้ว คลิก Open  

 

12.1 แถบแสดงพืน้ท่ีการท างาน
และไฟล์รูปท่ีเปิดขึน้มา สามารถ

คลิกสลับการท างานได้ 

 12.2 เลือกเคร่ืองมือ Marquee Tool 

ที่เหมาะสมกับงาน 
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13. ในท่ีน่ี ตรากรมเป็นลกัษณะของวงกลมท่ีตายตวัแน่นอน กใ็ช้ Selection Marquee Tool ท่ีเป็นวงกลม 

เม่ือคลิกแล้ว เมาสจ์ะเปล่ียนเป็นเคร่ืองหมาย + จากนัน้คลิกเมาสค้์างลากคลมุสญัลกัษณ์ 

 

* หากลากเสน้ประแลว้ไมค่รอบคลุมส่วนทีต่อ้งการ สามารถยกเลกิไดโ้ดยการคลกิเมาสน์อกเสน้ประเสน้ประ
กจ็ะหายไป แลว้ท าการลากใหม่ 

** สามารถ กด Shift คา้งไวเ้พื่อใหว้งกลมเสน้ประ มคีวามกลมไมเ่บีย้ว 

14. เมือ่ลากเสน้ selection ไดแ้ลว้ ท าการคดัลอกรปูภาพเพื่อน าไปวางยงัพืน้ทีก่ารท างานของเรา โดยการ 
ไปทีเ่มนู Edit > Copy หรอื CTRL+C 

การเลอืกใช ้เครื่องมอื Selection ต่างๆ แต่ละเครื่องมอืนัน้ตอ้งพจิารณาถงึรปูร่างๆของรปูภาพทีต่อ้งการเป็นหลกั  
1.รปูต่างทีเ่ป็นรปูทรงแน่นอนเชน่ รปูลกัษณะ วงกลม สี ่เหลีย่ม ใชเ้ครื่องมอื

 

2. รปูทรงทีไ่มต่ายตวัแน่นอน เช่น รปูคน หรอืสิง่ของ ใชเ้ครื่องมอื 

 

13. จุดเร่ิมต้นลากเส้น selection 

 

+ 
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15. กลบัไปยงัพืน้ทีก่ารท างาน แลว้ วางรปูภาพทีค่ดัลอก โดยการไปทีเ่มนู Edit>Paste  

 

รปูภาพท่ีท าการคดัลอกแล้วน ามาวางในพ้ืนท่ีการท างาน 

 

16. เม่ือท าการวางรปูภาพท่ีคดัลอกแล้ว จะเกิดภาพท่ีขนาดใหญ่หรือเลก็กว่าท่ีต้องการสามารถ 

ขยาย หรือลด ขนาดรปูในพ้ืนท่ีการท างานได้ โดยไปท่ี เมนู Edit > Free Transform หรือ CTRL+T 

 

Edit > Copy หรือ CTRL+C 

 

Edit > Paste หรือ CTRL+V 

 

15.1 สลับกลับพืน้ท่ีการท างาน  
โดยคลิกที่ ช่ือพืน้ท่ีการท างาน 

 

Edit > Free Transform หรือ CTRL+T 
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เม่ือย่อรปูได้ตามต้องการแล้ว กดเคร่ืองหมาย ถกู ด้านบน เพ่ือยืนยนัการลดขนาดรปูภาพ 

 
 

 

17. ท าการใส่เส้นขอบหรือเงา ตามต้องการวิธีการท าตามข้อ 9. 

18. น ารปูภาพมาตกแต่งส่วนท่ีว่างในพื้นท่ีการท างาน โดยการเปิดภาพท่ีต้องการเข้ามาใน

โปรแกรม Photoshop  วิธีการเปิดภาพดไูด้ท่ีข้อ 11. 

 

 

 

 

 

 

สามารถดงึหมุดยดึเพื่อขยายหรือ
ย่อได้ ตามต้องการและสามารถ

ย้ายรูปได้ตามต้องการ 

 

หากดงึหมุดยดึตรงมุมออกจะเป็นการขยาย 

 

หากดงึหมุดยดึตรงมุมเข้าจะเป็นการย่อ 

 

คลิก ถูก เพ่ือยืนยันการเปล่ียนแปลง 
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19.การน ารปูภาพไปทัง้หมด ท่านสามารถใช้ คียล์ดั คือ CTRL+A หรือ Select > A กไ็ด้ 

 

20. ท าการ Copy รปูท่ีต้องการเพ่ือน าไปวางยงัพื้นท่ีการท างาน โดยการกด CTRL+C หรือ 

Edit>Copy 

21. กลบัมายงัพื้นท่ีท างาน แล้ววางรปูท่ี Copy  ลงบนพ้ืนท่ีการท างาน  โดยการกด CTRL+V หรือ 
Edit>Paste 

 

** ท าการย้ายต าแหน่งรปูภาพไปไว้ตามท่ีต้องการ โดยใช้ Move Tool 

หากต้องการยา้ย ลบ หรอืจะตกแต่ง Effect ใดๆ กบัรปูนัน้จะต้องทราบก่อนวา่ วตัถตุ่างๆ นัน้อยู่ใน Layer อะไร 
จะต้องท าการเลือก Layer นัน้ก่อน ถึงจะกระท ากบั Layer นัน้ได ้

                        

รายชื่อ Layer ที่อยู่ในพืน้ที่การท างาน 

 
แสดงหรือไม่แสดงบนพืน้ที่การท างาน ปิดตาคือไม่แสดง เปิด

ตาคือแสดง 

 

ลบ Layer ที่ต้องการ โดยการคลิกเลอืก layer ที่ต้องการแล้ว
คลิกรูป ถงัขยะ 

 

สร้าง Layer ใหม่คลกิที่ รูปกระดาษ 

 

สร้าง ส าเนา Layer ที่เหมือนกนั
ให้ คลกิ layer ที่ต้องการ แล้ว
ลากส์ไปหาสัญลกัษณ์รูป

กระดาษ 
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22. ท าการลบบางส่วนของรปูภาพ ใช้ Tool ท่ีเป็นรปูยางลบ หรือ eraser  tool 

 

ดท่ีูแถบ Option Bar ของ Eraser จะมีหวัขนาดยางลบ ให้เลือกตามความเหมาะสมของรปูภาพ 

 

* หวัยางลบมีหลายแบบให้เลือกใช้ ใช้เลอืกใช้แบบใดกไ็ด้ท่ี เป็นแบบ Soft Round 

 

คลิกลบท่ีรปูภาพ ภาพท่ีลบกจ็ะจางลงไปเร่ือยๆ กลมกลืนกบัพื้นหลงั 

 

 

คลิกที่ Tools Eraser  

 

เลือกแบบ Soft Round และขนาดหัวยางลบตามต้องการ 

 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 145 
 
23. ปรบัความเข้มและจางของภาพให้กลมกลืน โดยคลิกปรบัท่ีค่า Opacity ของ Layer รปูภาพ

ตกแต่ง 

 

ผลลพัธท่ี์ได้ 

 

24. การบนัทึกเพ่ือน าไปใช้งานบนเวบ็ และ บนัทึกเพ่ือกลบัมาแก้ไขในภายหลงั 

 การเซฟเพื่อไปใชง้านบนเวบ็ไซต ์ไปที ่เมนู File > Save for web & devices เลอืกประเภทไฟล์
ตามตอ้งการตามภาพ แลว้กดปุม่ Save 

 

คลิกเลือก Layer ที่ต้องการปรับความเข้มจาง แล้วเลือก 
Opacity ตามต้องการ ยิ่งตัวเลขน้อย ความจางของรูปภาพ

ก็จะจางมากขึน้ 

 

เลือกประเภทไฟล์ที่ต้องการ แบบ Jpeg , GIF หรือ PNG 

 

คุณภาพของไฟล์ยิ่งมาก ขนาดไฟล์ยิ่งเพิ่มขึน้ 

 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 146 
 

 

 การบนัทึกเพ่ือน ากลบัมาแก้ไขได้ในภายหลงั เมื่อบนัทึกแล้วจะได้ไฟลน์ามสกลุ .psd ซ่ึงเป็น

นามสกลุไฟลข์อง Photoshop 

                    

 

 

 

 

 

เลือกไดรฟ์ที่ต้องการบันทึก 
ตัง้ช่ือไฟล์เป็นภาษาอังกฤษ 
เลือก Format เป็น Images 

Only จากนัน้คลิก Save 

 

เลือกไดรฟ์ที่ต้องการบันทึก 
ตัง้ช่ือไฟล์เป็นภาษาอังกฤษ 
เลือก Format เป็น Photoshop 

จากนัน้คลิก Save 
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การสร้าง Banner กระพริบ 

วิธีการสร้างแบนเนอรก์ระพริบนัน้ เพ่ือให้ผู้ใช้สงัเกตแุบนเนอรข์องเราได้ง่ายและสะดวกต่อการ
เข้าถึงข้อมลูสามารถท าได้ดงัน้ี 

1. สร้างพื้นท่ีแบนเนอรข์นาดท่ีต้องการ ตามตวัอย่างคือ 170*60 pixel 

 

2. ท าการตกแต่งสีพื้นหลงัตามต้องการเหมือนกบัการท าหวัเวบ็ไซต์ 

 

3. ท าการพิมพข้์อความท่ีต้องการลงไปในพื้นท่ีการท างาน 

 

4. ท าการเติม effect ให้กบัตวัอกัษร โดยการเติมเส้นขอบ (Stroke) เป็นสีท่ีต้องการ 
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5. เร่ิมสร้าง ภาพเคล่ือนไหว หรือ Animation โดยการเรียกแถบเครื่องมือข้ึนมา โดยไปท่ี 

Windows>Animation 

 

จะได้แถบการท าภาพเคล่ือนไหวข้ึนมา ท าการเปล่ียนแถบท าภาพเคล่ือนไหวเป็นแบบโหมด Frame 
Animation 

 

จะได้แถบ แบบน้ี 

 

ส่วนประกอบของ Windows Animation 

 

 

 

คลิกเพื่อเปล่ียนโหมด 

 

เฟรมการท างาน 

 ก าหนดเวลาการ
เปลี่ยนเฟรม 

 

ควบคุมการเล่น 

 

สร้างเฟรมใหม่ 

 

ลบเฟรมที่ต้องการ 

 

ก าหนดรอบการเล่น 
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6. ก าหนดจ านวนเวลาท่ีจะเปล่ียนเฟรมการเล่นโดยการคลิกท่ี ตวัเลข sec 

 

7. ท าการก าหนดรอบการเล่นของ animation 

 

8. ท าการสร้างเฟรม ถดัไปโดยการคลิกสญัลกัษณ์จะได้เฟรมใหม่ขึ้นมาอีก 1 เฟรม 

 

9. ท าการเปล่ียนสีเส้นขอบท่ีต้องการโดยดบัเบ้ิลคลิกเลือกเปล่ียนสีท่ี effect Stroke 

เลือกเฟรมที่ต้องการและจ านวน
วินาทีท่ีจะเปล่ียนเฟรม 

 

เลือกเป็น Forever เพื่อให้แสดง
วนรอบไปเร่ือยๆ 

 

คลิกที่สัญลักษณ์จะได้เฟรมใหม่
ขึน้มาอีก 1 เฟรม 
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จะได้เส้นขอบอีกสีหน่ึงในเฟรมท่ี 2 

 

** หากต้องการเปล่ียนอีกหน่ึงสี กส็ามารถเพ่ิมเฟรมท่ี 3 แล้วเลือกเฟรมท่ี 3 และท าการเปล่ียนสีเส้น
ขอบตามข้อ 8 ซ า้ไปเรื่อยๆ  

10. ท าการคลิกปุ่ ม Play เพ่ือเล่น Animation จะเล่นเปล่ียนสีไปเร่ือยๆ  

 

11. ท าการเซฟน าไปใช้บนเวบ็ไซต ์โดยการไปท่ี เมนู File>Save for Web & Device ต้องเลือก

ประเภทไฟลเ์ป็น GIF เท่านัน้จึงจะเล่น Animation ได้ 

ดับเบิล้คลิกที่ Stroke 

 

เปล่ียนสีที่ต้องการ แล้ว
กด OK 

 

คลิกที่ปุ่ม Play 
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การสรา้งกรอบรปูภาพบุคลากรหรือกรอบต่างๆ 

1. สร้างพื้นท่ีการท างานขึ้นมาขนาดตามต้องการหรือเปิด Background รปูท่ีต้องการ 

 

2. ท าการวาดเส้น section แบบส่ีเหล่ียม ในลกัษณะตามรปู 

 

เลือกประเภทไฟล์ GIF 
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3. ท าการเปิดรปูบคุลากรขึ้นมาในโปรแกรมไปท่ี File>Open เลือกรปูบคุลากรท่ีต้องการและท าการ

เลือกทัง้หมดของรปูภาพบคุลากรโดยเลือกค าสัง่ Select>All 

           Select All          

4. ท าการ copy รปูบคุลากรท่ีต้องการโดยไปท่ี Edit>Copy หรือ CTRL+C 

5. กลบัมายงัพื้นท่ีการท างาน จากนัน้เลือกค าสัง่ Edit>Paste Special>Paste into 

   

จะได้รปูตามภาพ 
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6. ใช้ Move Tool ท าการเคล่ือนย้ายรปูไปไว้ในต าแหน่งท่ีต้องการ หรือ ถ้ามีขนาดใหญ่หรือเลก็

เกินไปกท็ าการใช้ค าสัง่ Edit>Free Transform ในการลดขยายขนาดรปู 

 

 

7. จะได้กรอบรปูภาพดงัภาพ จากนัน้ท าการเซฟเพ่ือน าไปใช้งานโดยการไปท่ีเมนู File>Save for 

Web & Devices 

 

คลิกเพ่ือจัดการกับรูปภาพ เช่น เล่ือน ย่อ ขยาย 

 

คลิกเพ่ือเล่ือนกรอบใส่รูปภาพ 
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การลดขนาดรปูภาพเพ่ือใช้งาน 

1. เปิดไฟลภ์าพท่ีต้องขึ้นมาท่ีมีขนาดใหญ่ไม่สามารถลงในเวบ็ไซตไ์ด้ 

2. ไปท่ีเมนู Image > Image Size 

 

 

3. จะได้ไฟลใ์หม่ท่ีมีขนาดเลก็ลงมา 

                      

 

 

 

 

ถ้ามีเคร่ืองหมายลกูโซ่หมายถงึการลด
ขนาดให้มคีวามสัมพนัธ์ทัง้สองด้าน 

 



คู่มอืการใชง้านระบบเทม็เพลต็เวบ็ไซต ์Joomla 3.9x เบือ้งตน้ และ คู่มอืการใชง้าน Photoshop หน้า 155 
 

การปรบัความมืดและสว่างของรปูภาพท่ีจะใช้งาน 

1.เปิดไฟลร์ปูท่ีต้องการแก้ไขขึ้นมา 

2. ไปท่ีเมนู Image>Adjustment>Curve 

 

       

 
 

คลิกที่ตรงกลางเส้น แล้วดึงขึน้เพื่อเพิ่ม
แสงตกกระทบ 
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วิธีการปรบัเฉดสีของภาพให้เป็นสีโทนท่ีต้องการ 

1. เปิดภาพท่ีต้องการขึ้นมา  

 

2.จากนัน้ไปท่ีเมนู Images>adjustment>Color Balance 

 

ท าการดึงเฉดสีท่ีต้องการ แล้วกด OK 

     

 

ดงึเฉดสีที่ต้องการ 

 

ปรับส่วนของเงา Midtones และ 
Highlights 

 


